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Chapter 1 

Welcome to HyperStudio 

 

 

Overview of the User's Guide 
 

The User's Guide is designed to help you jump into HyperStudio 4.0. 

There are several chapters detailing new features, and an all-new tutorial.  The 

Reference Manual is a complete listing of HyperStudio's features, and how to use 

them. The User's Guide will help you start using HyperStudio 4.0 right out of the 

box. 

Later in this chapter is a description of everything on the HyperStudio CD. 

Installing HyperStudio is explained in Chapter 4. 

Experienced users will want to go right to Chapter 2 to read about all the 

new features and functions in HyperStudio 4.0.  Chapter 6 has a handy table of 

the keyboard shortcuts, while Chapter 7 lists some great tips and tricks.  

New users will find the tutorial in Chapter 5 a great way to learn 

HyperStudio.  A Brief History of Writing is a five-card stack. All of the artwork is 

located on the CD in a tutorial folder. New users will quickly gain confidence as 

they build this interesting, fun multimedia presentation. The tutorial also teaches 

the newest techniques and shortcuts, so experienced users should go through it 

as well to practice firsthand some of the features described in Chapter 2.  

As with all products from Knowledge Adventure, we value your comments 

and observations. Please feel free to contact us at hyperstudio@education.com. 

To purchase other HyperStudio manuals or guides, call Knowledge Adventure at 

(800) 545-7677. All the manuals (except the Teacher's Guide) can be 

downloaded from the HyperStudio CD. Check www.hyperstudio.com periodically 

for updates to the manuals. 
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What’s On the HyperStudio CD? 
 
Software 

HyperStudio 4 
HyperStudio 4 Player 
Flaming Pear Graphic Filter 
VR ObjectWorx ™ Demo 
VR PanoWorx ™ Demo 
Aladdin StuffIt Lite ™ 3.6 
Aladdin DropStuff ™ 5.5 
Aladdin DropZip ™ 5.5 
Aladdin Expander ™ 5.5 
Adobe® Acrobat™ Reader 4.0 
QuickTime® 4.0 
Morph™ 2.5 
 

Features 
HyperStudio Fonts 
HyperStudio 4 Easy Effects 
HyperStudio 4 Tutorial 
HyperStudio Ready Made Cards 

 
Resources 

Professional Development Materials 
Teacher Lessons 
Student Projects 
User Projects 

 
Manuals and Guides 

HyperStudio 4 Teacher’s Guide 
HyperStudio 4 User’s Guide 
HyperStudio 4 Reference Manual 
HyperLogo™ 3.0 Reference Manual 

 
Macintosh Only 

Animation Maker 
HyperStudio Icon Librarian 
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What’s On the HyperStudio Program CD? 
 

The HyperStudio Home Stack environment provides access to everything 

within the HyperStudio folder as well as the HyperStudio CD-ROM.   The 

HyperStudio CD is a critical resource for beginners. Experienced users will like 

the streamlined access to over 400 MB of new content, stacks, and online 

documentation. The Home Stack presents the following sections of material: 

Discover, Learn, and Excel.  Each section is designed to explain or demonstrate 

the enormously varied aspects of HyperStudio—from getting started in a 

classroom to delivering professional presentations over the Internet. In any case, 

HyperStudio is fun! You don't need the CD to build projects but you must have 

the CD in your disk drive to get full benefit of the HyperStudio Home Stack. 

 

 
 
 

 
Discover   Learn Excel 

 
Who was your childhood hero? Was it Thor Heyerdahl, who voyaged on a 

balsawood raft from Peru to the Polynesian Islands? Was it aviator Amelia 

Earhart, the first woman to fly alone across the Atlantic Ocean and to receive the 

Distinguished Flying Cross?  These people and other heroes were participants in 

the adventure of discovery. Discovery with HyperStudio continues to be one of 

the most exciting activities we can pursue. 

 

HyperStudio’s CD-ROM offers a wide variety of stacks for discovery. 

Discover how to get anywhere in the Home Stack with two clicks. Discover the 

exciting new features of HyperStudio 4.0. You can also discover the right lesson 

or student project just for your needs. Discover how others have created 

multimedia projects you can modify for any purpose you like. Wander down the 

HyperStudio Street to view stacks on cool technologies and links to pricing and 

licensing information.  

 



 8

When you want to push the limits of creation, discover what Morph can do! 

Both the Morph manual and Morph program are included on the CD. Morph 

allows you to transform one picture into another in a seamless transition.  While 

the possibilities for fun are endless, Morph can show the transition from a tadpole 

to a frog, or the transformation of a renovated building.  What once could exist 

only in the imagination is now made visible - all in the Discover section of the 

HyperStudio Home Stack. 

 

 
 

 
 
 

Discover   Learn Excel 
 

From an introduction of essential skills to the new Click Programming 

environment for HyperLogo, HyperStudio provides opportunities to learn all sorts 

of new skills at your own speed.  

 

How often have you wished for a way to present information creatively? 

Whether you want to make a simple slide show in a few clicks or create an 

original interactive multimedia description of an abstract concept, HyperStudio is 

remarkable in its ability to facilitate solutions. Use any of the Ready-Made-Cards 

for specific projects and learn tips on introducing multimedia creativity into your 

projects from the Easy Effects stack. You can also learn what's happening 'under 

the hood' of the Home Stack and many selected projects by clicking the 

annotation icons. Finally, excite your creativity by learning the ways HyperStudio 

helps you make things happen. These and all other stacks on the CD are there to 

inspire you to try new ways to tell your story. 

 

The new HyperStudio CD-ROM has lots to see and enjoy.  For some real 

insight for creating projects, be sure to click the "about this stack" icon and any 

question mark icons placed on the expert projects. 
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Discover   Learn Excel 
 

We at Knowledge Adventure appreciate how important good training 

materials and efficient service are. With terrific support from a solid company, 

educators and professionals can excel far beyond anyone's imagination. The 

vast network of HyperStudio users didn't happen by accident. A whole generation 

of teachers, students and individuals has been using HyperStudio for many 

years. As a result, there's an abundance of books and professional development 

materials for beginning as well as experienced users.  Knowledge Adventure is 

dedicated to supporting this information network and helping it grow.  We've 

provided many of these materials on the CD as well as links on where to find 

more. There are many ways to be a part of the HyperStudio community that 

shares information and creates a more dynamic learning environment.  

 

• The Adventurer’s Club candidates are professionals and program 

enthusiasts who currently use our products at conferences, seminars, and 

in-services. Here you can learn how to be an official member and receive 

these benefits: support through product literature, pre-release CD-ROMs, 

door prizes; networking opportunities; free software; opportunities to learn 

about the latest technologies and software products. Can’t wait to see it on 

your CD-ROM? E-mail schoolsales@knowledgeadventure.com for 

information. 

• Professional Development offers numerous training resources and 

opportunities. A few of the resources available are free training materials; 

grants; contests; templates and stacks; HyperStudio books, disks, and 

CD-ROMs; third-party companion products such as a Portfolio 

Assessment Toolkit® or Multimedia Yearbook Toolkit®; and web 

resources such as project ideas, foreign language links, lesson plans, and 
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biology websites. Training opportunities include the Knowledge Adventure 

conference schedule; a list of HyperStudio workshop leaders and 

workshop offerings; a list of colleges that offer courses using HyperStudio; 

Webring and ListServ. 

• Workshop-in-a-Box is virtually a self-run training program. One person 

reviews and presents the material to the other participants. This is a great 

way for colleagues to learn HyperStudio basics in a supportive 

environment. 

  

Customer Service makes all the famous HyperStudio resources available, 

and Technical Support gives you peace of mind as well as real help in times of 

need. Technical support contacts and numbers are provided in the Home Stack, 

listed in the Teacher’s Guide, the Reference Manual, the User’s Guide, and on 

the CD-ROM.  

 
Visit 

For more ways to learn and create with Hyperstudio, visit the following 

Internet sites: 

Hyperstudio.com – Provides Hyperstudio news, information and 

resources to help you create any project. Included is the Hyperstudio 

update library, stack galleries, educator resources, marketing and support 

contacts, user forums and much more. 

 
SiteCentral.com – Helpful information for using SiteCentral, including 

answers to frequently asked questions, sample sites and technical 

support. 

 
KnowledgeAdventure.com – Features a complete reference library for 

using Knowledge Adventure products and services. 
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CurriculumAdvantage.com - Creates partnerships with educators who 

want the best in K – 12 classroom technology. Includes courseware, 

instructional management systems, consultation, training and more. 

 
HSNetwork.com – International resource for Hyperstudio users. 

 
HyperStudio Web Ring – A list of links to Hyperstudio- and SiteCentral- 

related websites that are perfect for use in the classroom. 

 

You’ll be delighted with the range of possibilities! 
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Chapter 2 
New Features in HyperStudio 4.0 

 
 

 
Tip of the Day 
Formerly available exclusively on Mac, Tip of the Day is now available on the 

Windows platform. As on the Mac, Tip of the Day is in the home directory start-up 

stack.  A new Tip of the Day card displays at each start up, and can be 

customized for your own needs. Clicking on the “Home” button on the Tip of the 

Day card takes you to the Home Stack. 

 

Media Library Window 
The Options menu features a new selection called Show Media Window. Drag 

and drop elements onto a card from within its drop-down menu. 

 

Upgraded Media Library 
The HyperStudio Media Library has been upgraded and expanded. The material 

is copyright-friendly and organized for easy use.  You can drag and drop it (see 

Drag and Drop) to the card you are working on. Simplify access to content with 

the Media Library Ready Made Cards (from the File menu). It can be accessed 

either by clicking Options on the menu bar and selecting Show Media Window, 

or by Clicking File on the menu and selecting Add Clip Art…. 

 

Drag-and-Drop Feature 
This feature simplifies the process of integrating wonderful graphics, text, 

movies, sounds, etc., by allowing you to drag and drop these elements to the 

card being worked on. These elements can be from the media library, desktop, a 

web page, or any source you have available to your computer. A graphic can 

simply be dropped on to the card, or you can use the Option key on the Mac (Alt 

on Windows) to drop the picture and be given options on how to drop it. See 

Chapter 12 in the HyperStudio 4 Reference Manual. 
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HyperLogo “Click Programming” 
Click Programming is the new point-and-click programming interface for 

HyperLogo. This new editing tool allows even inexperienced users to do 

HyperLogo scripting, and greatly expands their scripting possibilities.  This tool is 

located in the Actions dialog box. 

 

Printable and Resizable Storyboards 
From the Extras menu, selecting Storyboard provides the ability to print 

individual, selected cards and card-image thumbnails right from the Storyboard 

window. This window is now resizable. 

 

Stack to Go 
This new presentation tool allows someone who does not have HyperStudio to 

view a stack. The Stack To Go option (in the “Save As Type” drop-down menu) 

creates an application that includes the HyperStudio player with the stack.  

 

QuickTime Transitions 
Moving from card to card has never been so much fun!  QuickTime transitions 

feature ten new effects with dozens of settings for seemingly unlimited 

possibilities. This requires QuickTime 4.0 installation. 

 

Transparent Scrollable Text 
Transparent text objects can now scroll with the background imagery appearing 

underneath. 

 

Sequencer NBA  
Formerly called Timer New Button Action, the Sequencer NBA enables precision 

timing for running buttons or objects with actions. It augments the ButtonRunner 

NBA with the ability to set times for each button action.  To use this feature, drag 

the objects from the pane on the left to the one on the right.  Click on the 0.000 
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time to enter a new time and press ENTER. This will run the action on the 

selected object at the time selected. 

 

Blabbermouth and AutoRecord NBA  
The text-to-speech enabler Blabbermouth NBA is now available on Windows. 

This button action reads aloud text in field. NBA has been added to enhance 

sound capabilities, allowing the user to record sounds to a specified file. 

 

Enhanced Roll Credits NBA 
Horizontal scrolling has been added to the original vertical scrolling by the Roll 

Credits NBA. 

 

Font Styles on Buttons 
From the Button Appearance dialog box, select Features and click the Styles 

button. 

 

StarField New Button Action 
This NBA creates moving stars on your card. Formerly only on Mac, this is now 

available to Windows users as well. 

 

Masked Password Entry 
The Preference dialog now asks you to enter your password twice. This is found 

under Preferences in the Edit menu (Ctrl/Command ;). 

 

“Snap-To” Alignment Grid 
Use “Snap-To” to precisely align objects on a card.  This is found on the Options 
Menu under the selection Grid. 

 

Scale and Rotate Enhanced 
Irregularly shaped areas can be selected and have scale and rotate functions 

applied to them. 
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RTF Text Support  
Users can now import .rtf files and retain formatting that is supported by the 

current text object. 

 

Text Field Tamer 
Text Tamer is found under Extras on the menu bar. This allows the user to play 

with the read-only attribute of text fields found on the card and the stack. 

 

256 On-screen Color Palette 
Setting your preferences to experienced user gives you this expanded Color 
selection from the menu bar. This was found previously on HSWin 1.0 and 

HSMac 2.0.  Included in this palette are 16 upgraded patterns. 

 

Enhanced Interactive Cursors 
When creating a graphic, button, card or stack, select the features button. Click 

the Custom Cursor checkbox and select one of the files (.ani or.cur) from the 

menu. This will create an animated or a static custom cursor. 

 

Context-sensitive Menus 
Right-click the mouse on an item such as a button, card, or graphic object to get 

enhancement menus that relate to the type of object selected. 

 

Decimal Input for Times 
When making a selection from the Actions dialog box, choose Automatic Timers 

under Things to Do. The dialog box you see next asks you to enter a time in 

tenths of a second. This provides greater precision of control for auto-timed 

actions. 
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Ready Made Cards Expanded 
Customize your own submenu of Ready Made Cards by adding your own folders 

to the Rdymcard directory. These folders automatically become part of the 

submenu. Now entire stacks can also be placed here and will be imported when 

selected. See Chapter 5 in the HyperStudio Reference Manual. 

 

Create Your Own Mascot 
Your own mascot can now replace Addy in the help dialog boxes. Create a 

90x90 .bmp file called “mascot.bmp” and place it in the same folder as the 

HyperStudio application. The pixel in the top left corner will be the transparent 

color. 

 
Go to URL Action 
Similar to the Netpage NBA function, this function is found in Places to Go in the 

Actions dialog box.  

 

Auto URL Action in Text Objects 
Typing http://www.hyperstudio.com (or just www.hyperstudio.com) in a text 

object automatically turns the phrase into a hypertext link with a Go To URL 

action associated with it. 

 

Graphic Object Effects 
All effects and Plug-in filters in the Edit menu work on graphic objects. Select an 

object and use one of the effects from this menu on it. 

 

Object Transparency 
The Appearance dialog box has a slider to select how transparent you want the 

object to be. 
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Enhanced User-Defined Preferences 

The About This Stack dialog now includes a checkbox to save the stack settings 

as the default. 

 

Hot/Live Edit Display 
When moving an object, a picture of the object is displayed, rather than just an 

outline. 

 

Menu Item Names Changed 
In the Objects menu, the item names are more specific and clear. See Chapter 2 

in the HyperStudio Reference Manual.  

 

Format Menu Added 
Selections from this new menu allow the user to set defaults on text creation. It 

also allows users to change all selected text in a text box. The font currently in 

use is displayed in this box. Selecting Font from this menu shows a list of all the 

recently used fonts.  

 

Highest Compression Mode is no longer Default 
See the Edit menu under Preferences.  The last option in Stack Preferences is 

no longer checked by default, and must be checked to enable compression. 

 

Uncheck Highlight Option on Invisible Buttons 
The Highlight option automatically unchecks when an invisible button is created. 

 

Animation System Enhancements 
Path editing for animations has been greatly expanded. 

 
Morph 2.5 Included! 
Gyrphon Software’s Morph 2.5 is now bundled with HyperStudio 4 at no extra 

charge.  Mild-to-totally-wild effects are the result of creating QuickTime or AVI 
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movies that smoothly transition from one object or image to another. The user 

can also create warping and caricature effects of any still image or dynamic 

morphs between two digital movies. The resulting movies are easily imported into 

a HyperStudio stack. A short Morph tutorial concludes this chapter. 

 

Terrific Upgrade and Licensing Policies 
For the first time, HyperStudio 4 upgrades will be available through your favorite 

authorized software reseller. Contact Knowledge Adventure for the reseller 

nearest you by calling 800-545-7677. Outside the USA and Canada call 310-783-

0197 or email: hyperstudio@education.com. Visit the HyperStudio website for 

more news and information about HyperStudio 4: http://www.hyperstudio.com. 

 



 19

HyperStudio and Morph Pro 2.5 
A Brief Tutorial 

Morph Pro 2.5 is bundled with HyperStudio, meaning the complete program is on 

the HyperStudio Program CD. The Morph Reference Manual is also on the CD 

and can be printed. Morph creates a movie or “video” file that can then be played 

in a HyperStudio stack. Morph movies show transitions from one image to 

another, as if one were being transformed to the other. It can be used to show 

serious transformations such as the effect of erosion over time, or fun ones, like 

the growth of a puppy. The following tutorial will create a stack with a Morph 

movie. This tutorial assumes a basic understanding of HyperStudio. New users 

should start with a HyperStudio tutorial. 

 

The first step is to create or select the two images to be morphed. Open a new 

stack in HyperStudio, and set the stack colors to 300 x 400 millions of colors. 

 

1. Create a basic background on the first card. 

 

2. Create a new scratch card and draw separate scene elements (sun, 

clouds, small plant, small bushes).  You must have a scratch card! 
 

3. Use the lasso tool to select, copy and paste the elements one at a time 

back onto the scratch card. When pasting (while the red-dotted line is 

visible), press command-G or Crtl-G. This makes the elements Graphic 

Objects. (If you make the element on the scratch card a graphic object, 

then paste it, you won't be able to modify it later in step 6.)  

 

4. One at a time, copy and paste the graphic objects onto the background 

card. Position them as desired with the Edit/Selector (arrow) tool. 

 

5. Copy the first card and paste it, creating a new card exactly the same. 

Delete the elements on the second card. 
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6. Move to the scratch card (Card 3) and scale the elements up. Use Scale 

and Rotate from the Effects option on the Edit menu. 

 

7. Select, then copy and paste the bigger plants into graphic objects as done 

in step 3. 

 

8. Copy and paste them onto Card 2. Position them in the same place as the 

smaller elements on the first card. These are the images that the images 

on the first card will “morph” to. 

 

9. Save your stack, then move to Card 1, and select Export Screen from the 

File menu. Give it a name (Picture1). 

 

10. Move to Card 2, and select Export Screen from the File menu. Give it a 

name (Picture2). Save your stack. 

 

Now that the images are made, launch Morph Pro 2.5 to create a new morph 

document movie.  

 

11. Select Sequence>Read Start Image... and choose Picture1. Select 

Sequence>Read End Image... and choose Picture2. Select 

Windows>Start Image 1 and Windows>Start Image 2. 

 

12. On the start image, use the red square dot on the tool bar to add points 

that outline the elements that change between the start and end images. 

Readjust the points on the end image with the arrow tool. The more points 

the higher the quality of movie that will result.  

 

13. Select File>Export Movie... Give the movie a short name with no spaces, 

ending with .MOV for cross-platform purposes. From the Windows 
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platform, under File select Save as…and save the movie with an .avi. 

extension.  From the movie options dialog, choose Video compression 

(default) and a minimum of 8 to a maximum 15 frames per second (or just 

use the default 10 fps). Click OK. Wait until the movie is finished building. 

 

Now, open HyperStudio and create a new stack to play your movie. Set size to 

500 x 400 pixels, and color to 16 bit/thousands of colors. 

 

14. Make a button or other object to play the movie. At the Things to do 

dialog, choose Play a Movie. Choose the morph movie created in step 14. 

Select "no" when asked if you want to resize the image. 

 

15. Using the draw/paint tools, fill in the sides of the card background to match 

up with the imported 1st frame of the movie. This can be tricky but it's a 

good challenge and fun. 

 

16. Save the stack, click the Browse tool (browse mode) and try out the 

movie. So cool! 

 

The movie and stack size can vary, however, the method above produces the 

best results with a minimum of work. The stack size could have easily been 

640x480 but should not be shorter in height than the morph movie. Also, while 

step 15 isn't necessary, it does result in a neat "hidden movie" effect and offers a 

somewhat challenging opportunity to use the paint tools. Remember, the 

complete Morph manual is on the HyperStudio Program CD.  
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Chapter 3 
Using HyperLogo, a Scripting Language for 

HyperStudio 
 
About HyperLogo 
 
What is HyperLogo? 
 
HyperLogo is the scripting language in HyperStudio. HyperLogo provides you 

with the powerful combination of the programming language Logo and the ability 

to control many aspects of HyperStudio using built-in callbacks. This means 

HyperLogo can be used for something as simple as quitting HyperStudio to 

something as complex as building a smart address index using Logo's list 

processing capabilities.  

 

You should have some understanding of HyperStudio before you begin using 

HyperLogo. For example, you should know how to make and name objects, 

create links to different cards and stacks, and use Actions like Play a sound. This 

does not mean that you need to be an expert HyperStudio user to begin using 

HyperLogo. In fact, once you are familiar with a few HyperStudio basics, you can 

begin to use the Click Programming environment in HyperLogo to manipulate 

HyperStudio objects. 

 

Why Use HyperLogo? 
 

HyperStudio has such a wealth of features that you may wonder why you would 

need to use HyperLogo.  HyperLogo makes it possible to do things that are either 

impossible or difficult using HyperStudio alone. For example, in HyperLogo you 

can program fine control over movie playback, create a virtual calculator, or even 

create a drawing program. The long answer is HyperLogo is the Logo 

programming language, and the sky's the limit! 
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There are three categories where HyperLogo really excels: 

 

 1. Accessing the built-in HyperStudio Callbacks. Callback commands 

manipulation of almost every aspect of HyperStudio. Callbacks can be used to 

show and hide a sequence of objects, change the size or position of objects, time 

events, or change text. Since there are so many HyperStudio callbacks available, 

all of which can be combined with other HyperLogo commands, it is virtually 

impossible to list every possible way to use them. 

 

2. Turtle Graphics. Turtle Graphics offer a way to visually explore 

mathematics, geometry, logic and other higher order thinking skills. The exciting 

news is that Turtle Graphic projects can range in scope from a young child 

exploring concepts like forward, back, left, and right, to a more experienced user 

creating custom brushes for a free style painting program, to an advanced user 

building 3D models of molecules and graphic simulators. 

 

3. Basic Programming Capabilities. HyperLogo has a wide range of 

programming commands that allow you to do tasks such as create, open, and 

change disk based text files (Text IO), manipulate data, perform calculations and 

"make decisions" based upon current values and other criteria. This 

programming language can be used to create very sophisticated applications.  

 

Logo History and Philosophy 
 

Logo is more than a programming language. Developed in the 1960s, it was built 

on the philosophy of learning called Constructivism. This theory of learning is 

largely based upon the studies of Swiss psychologist, Jean Piaget. Logo was 

designed to support constructive learning processes. 
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Since Logo represents both a programming language and a philosophy, it's 

important to take a quick look at both aspects. Many books and websites are 

dedicated to describing the essence and merits of Constructivism. 

“Constructivist” and “Constructionist” are terms used in reference to the belief in 

the construction of knowledge.  This belief can be summarized by saying: We 

build knowledge based upon what we know by exploring and interacting with the 

world around us. 

 

This concept is very important since Logo provides the tools, the language, and 

environment to create a miniature world that can be explored and manipulated. 

You can use simple Logo commands immediately and effectively, but you can 

also build upon this knowledge by combining commands in increasingly complex 

ways. Logo is a programming language that expands in potential as your 

understanding grows. 

 

Today there are many implementations (versions) of Logo used throughout the 

world. Not every version of Logo is exactly the same as every other, but many 

Logo scripts work basically the same, regardless of the Logo application being 

used. This means that you have a wide variety of reference materials available, 

in the form of books and websites that represent years of programming and 

teaching experience in using Logo. 

 

From 1967, when Logo first emerged from the MIT Artificial Intelligence 

Laboratory, to today, Logo has been a unique programming language that has 

experienced innovation and updates without losing its character or usability. 

HyperLogo blends the rich, long history of Logo with the cutting-edge, multimedia 

features found in HyperStudio.  
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Introduction to HyperLogo 
 

HyperStudio 4 includes the next generation of HyperLogo. Numerous features 

have been added to make HyperLogo accessible and easy to use. The following 

overview will help you get started with HyperLogo. Refer to the HyperLogo 

Reference Manual, or use online Help within the HyperLogo environment for 

complete descriptions.  The HyperLogo Reference Manual can be printed from 

the HyperStudio Program CD, and is available for purchase at the HyperStudio 

website. 

 

Opening HyperLogo  

 

 There are a few different ways to enter the HyperLogo scripting environment:  

 

Actions  

 

If you are starting from scratch, go through the process of making, 

naming, and positioning a button, graphic or text object, then select 

Actions / Things to do / Use HyperLogo. You are now in the HyperLogo 

script window. Below the script window is the Click Programming window. 

This will be discussed later.  

 

HyperLogo Menu  

 

There are three categories of HyperLogo options available in the this 

menu: 

 

HyperLogo Run Box This allows you to test HyperLogo statements 

without entering the HyperLogo environment. In other words, any 

HyperLogo commands typed into the Run Box window will execute 



 26

as soon as you press the Return key on Mac, or the Enter key on 

Windows. 

 

Edit Item Script This option is used with specific HyperStudio 

objects: buttons, graphics, and text. Using the Edit/Selector, (the 

arrow on the Tools palette of the menu bar), click on the object to 

be edited, then select Edit Item Script from the HyperLogo menu. 

 

HyperStudio Events There are several events listed here such as 

Edit Arriving at this stack and Script and Edit Leaving this card 

Script.  HyperLogo scripts attached to these events are executed 

when the event occurs in HyperStudio. To enter HyperLogo, simply 

select the event from the choices available. 

 

Keyboard Shortcuts  

 

If an object already has HyperLogo as an associated action, the easiest 

way to get into HyperLogo is to use the Keyboard shortcut. Select the Browse 

tool (the hand from the Tools palette on the menu bar). On Mac, hold down the 

command key (Apple or clover leaf) and click on the object with the mouse. On 

Windows, hold down the Alt key and click on the object with the mouse. 

 

Contextual Menu 

 

Choose the Edit/Selector tool, (the arrow from the Tools palette on the 

menu bar), hold down the Ctrl/Command key and click on the object with the 

mouse, then select Action / Use HyperLogo. 
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The HyperLogo Environment – Script Window 
 

A Script window opens automatically when entering HyperLogo. Each 

Script window is attached to a specific HyperStudio object such as a button or 

card. It can also be attached to a specific HyperStudio event such as Arriving at 

this stack. This is the traditional HyperLogo window where scripts are manually 

typed and edited.  

 

File Menu 
 

Quit / Exit HyperLogo 

 

This leaves HyperLogo. Before leaving, all windows are closed. If any 

changes have been made, you will be given the option to save, not save, or 

cancel and not leave HyperLogo. Leaving HyperLogo will take you back to 

HyperStudio, where you can execute any commands in the Script window. 

 

Edit Menu  
  

Preferences 

 

There are several preference options available for customizing the 

HyperLogo environment. New users will want to maintain the default settings that 

automatically open the Click Programming window. More experienced users may 

want to optimize the environment based upon their personal programming style 

and needs. 

 

Syntax Coloring 

 

This reformats the text in the Script window so that certain types of text 

appear in different colors. This makes it easier to read and edit scripts. 
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Customize these color settings by selecting Edit / Preferences / Fonts and Colors 

within the HyperLogo environment.  The default colors are as follows: 

     

; comments are green.  HyperLogo ignores text that begins 

with a semicolon. It's good to develop a habit of providing your 

scripts with brief descriptions about what is happening. 

 

COMMANDS are blue. Many scripters capitalize commands, 

also referred to as Primitives and calls. 

 

Words are purple. Words are a fundamental aspect of the 

Logo language and are used for things such as naming variables. 

Words are also very important to HyperLogo callbacks in defining 

the parameters of HyperStudio objects such as "CardName, 

"ObjectName, and "ObjectType.  

 

Everything else is black. Everything else consists of such 

things as ProcedureNames: variables, numbers, special character 

and symbols, etc. 

 

Pretty Print 

 

This is another feature that reformats the script to make it easier to read. 

Commands that appear within bracketed lists, such as the commands executed 

in a REPEAT loop, are placed on separate lines and indented. 

 

 

Find Menu  
 

 The various Find and Replace commands in the Find menu work within 

the HyperLogo environment. 
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Click Programming Menu  
 

 Click Programming Window  

 

 This point-and-click programming interface provides complete access to 

all of the HyperLogo commands available. Now you do not need to try to 

remember every command in the HyperLogo language, whether it uses 

parameters, or what those parameters are supposed to be. Click Programming 

will do the typing, then show where and even how to fill in the blanks.  

 

 Parameter Pickers  

 

 Parameter Pickers are pop-up menus and dialogs that help set 

appropriate parameters for commands in the Click Programming window. There 

are a wide variety of Parameter Pickers available. To open a Parameter Picker 

on Mac, click and hold on the parameter until the Picker pops up. On Windows, 

press the CTRL key and click the parameter. 

 

Help Menu  
 

The HyperLogo Help system is a context-sensitive online reference 

manual. In other words, Help will try to help you find the Help you need. When a 

command is selected (highlighted), Help will open with the command’s 

description showing. If nothing is selected, Help will open on the Help Index. 

There are several ways to enter Help in HyperLogo: 

 

1. From the Click Programming window, select the Help button.  
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2. Menu selection: on Windows, select Help from the Help menu. On Mac, 

select Help from the Click Programming menu. 

 

3. Keyboard shortcuts, on Mac, press Command+H. On Windows, press 

CTRL+H. 

 

 

Entering Commands with Click Programming: 
 A Tutorial Introduction 
 

To see how click programming works, create a simple script that draws a colored 

box at a particular position on the current card. Along the way, learn how a few of 

the parameter pickers work.  

 

To begin, create a new button and pick Use HyperLogo for an action.  The Click 

Programming window and an empty scripting window appear. The area at the top 

of the Click Programming dialog is the command you're building; this is the 

command prototype. You could just type the command here, but we'll fill it in with 

the point-and-click command lists to illustrate the simplicity of this method. 

 

What We Will Do 

 

The commands we'll use are Turtle Graphics commands, so start by picking 

Turtle Graphics from the left list. Scroll down to find this entry. Once you select 

Turtle Graphics, you'll see a list of the graphics commands in the right list. 

 

The basic plan involves three steps: 

 

Pick a location. 

Pick a color. 

Draw the box. 
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1. Pick a Location 
 

Picking a location involves setting the drawing turtle to a specific location on the 

card. This involves  trial and error with the text based HyperLogo environment, 

but Click Programming offers a speedier alternative.  

 

There are three commands needed from the graphics commands list on the right 

to move the turtle. First, lift the pen with the PENUP command, then move to the 

new position with the SETPOS command, and finally put the pen down with the 

PENDOWN command. 

 

Scroll down to PENUP and select this command. After it pops up in the 

command prototype area, click Enter (Windows) or press Return (Mac). The 

command shows up in the script dialog, where you can edit it, delete it, or do 

whatever else can be done with a text editor. 

 

Next, to move the mouse to a position on the card; use the Turtle Graphics 

SETPOS command. Scroll down and select that command. The command 

prototype you will see is SETPOS point. 

 

Lowercase letters signify a parameter, a local variable. You need to fill in a value 

here. You could just type the value right in to the command prototype. Even if 

you do, you can still go back and try the parameter picker. 

 

Parameter pickers give you point-and-click selection of common parameter 

values. To get to the parameter picker, move the mouse over the parameter, 

then press and hold Ctrl (on Windows) while clicking the mouse button. On 

Macintosh simply click the mouse button. You'll see a pop-up menu. There are 

only two choices for this particular parameter: The first is <Use Keyboard>, which 

reminds you that you have the option of typing in the parameters. The second, 
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and the one you should select now, is <Use Pixel Picker>. Select the pixel picker. 

Dismiss the alert that shows you what is going on, and you will see a copy of the 

card image. Click the location at which you would like to begin. The copy of the 

card vanishes, and the command prototype will fill with the correct turtle graphics 

coordinate. 

 

If it's a bit off, use the pixel picker again, or edit the values just as you would edit 

text in the script window. 

 

Enter the prototype command in the script by pressing the return key. 

 

The last step in positioning the turtle is to add the PENDOWN command to your 

script. Select the PENDOWN command from the list on the right then press 

return. 

 

2. Pick a Color 
 

This step is optional, but it demonstrates one of the coolest parameter pickers! 

 

Pick SETPCRGB from the command list. This command sets the drawing color 

to any red-green-blue value you choose. That's very powerful, but how many 

people know that the correct number for turquoise is 0-65535 ? 

 

To make the color choice easier, simply press on the parameter and choose the 

Color Picker from the pop-up menu. From the standard color picker used 

throughout the system software, pick a color and click OK. The correct RGB color 

values are entered into a list.  

 

Press return to enter the command in the script window. 
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3. Draw the Box 
 

Drawing a box involves moving forward and turning right four times. Repeating 

an action four times is a good opportunity to use a REPEAT command. Start by 

picking Flow of Control from the left list; this switches the commands available in 

the right list. Scroll down and pick the REPEAT command. 

 

The REPEAT command has two parameters. The first is an expression into 

which you should type the number 4 and then hit the tab key to move to the next 

parameter. You can also use the parameter picker that will give you the chance 

to use a really cool calculator. It works like an electronic calculator. Instead of 

actually calculating a result, though, it creates the HyperLogo text to calculate the 

result in the script. Pick your method, but whichever you choose, use 4 for the 

expression. Once you've finished, press the tab key to move to the next 

parameter. 

 

The REPEAT command uses a list of statements, and repeats the commands in 

that list as many times as specified. In this case, it will repeat the commands in 

the list four times. The fact that there can be more than one command in the list 

accounts for something rather peculiar that you're about to see. 

 

Enter the FORWARD command, which will draw a line. With the statement 

parameter highlighted, pick Turtle Graphics from the left list, then pick 

FORWARD from the right list. The parameter is replaced by the new command, 

but a new statement parameter appears right after the FORWARD command. 

This lets you enter as many commands as you like (or none at all). When you 

finally enter the prototype command in the script window, the unused statement 

parameter will vanish. 

 

Moving along, enter 50 for the expression after the FORWARD command, then 

press the tab key to select the statement parameter again. Pick RIGHT from the 
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command list, and enter 90 for the angle. Finally, press return to enter the 

command in the script window. 

 

This finishes up your first Click Programming script. Now leave the HyperLogo 

scripting environment and try the script. At some point, look through the rest of 

the topics on Click Programming, where you'll find descriptions of the remaining 

parameter pickers, comments on using variables, and two features that record 

how you use Click Programming and tailor the environment to help you work 

faster. Remember there is an entire Logo manual available on the HyperStudio 

Program CD. 

 

 

HyperLogo Resources included on the HyperStudio Program CD 
 

The HyperStudio Program CD includes a variety of tutorials for HyperLogo. Both 

Exploring HyperLogo and Click Programming with HyperLogo 3.0 contain 

information about using HyperLogo, and include a variety of scripts and project 

ideas; however, they do so in different ways.  

 

Exploring HyperLogo with Bill Lynn is a step-by-step instructional guide for 

building HyperStudio projects that use HyperLogo. Exploring HyperLogo is a 

PDF document located in the Manuals folder on the HyperStudio Program CD.  

You are free to print this out for personal and academic use.  Click Programming 

with HyperLogo 3.0 with Dawn Thompson is a stack-based tutorial with working 

examples and numerous ready-to-use scripts that can be freely pasted into 

HyperStudio stacks. 

 

Since each tutorial offers unique ideas and methods, explore both at your own 

pace. Either skip around to the topics of greatest interest, or systematically 

complete each tutorial from start to finish. 
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Exploring HyperLogo - PDF Tutorial 

 

The HyperLogo Tutorial.pdf is located in the Manuals directory (folder on Mac) of 

the HyperStudio Program CD. Print this PDF file to make it easier to follow the 

step-by-step directions for building these HyperLogo projects in HyperStudio. An 

accompanying set of clip art is included in the HyperLogo folder, entitled 

HyperLogo Tutorial Art. 

 

HyperLogo has been significantly enhanced since Exploring HyperLogo was 

originally written. Although new features such as Click Programming and Online 

Help are not used specifically in the tutorial lessons, all of the HyperLogo scripts 

and HyperStudio functions work today as they did then. The variety of scripts and 

in depth descriptions found in this tutorial will provide you with a very solid base 

in learning to program with HyperLogo. 

 

Click Programming with HyperLogo 3.0 - New Stack-Based Tutorial 

 

To get started, launch the Logomenu.stk found in the HyperLogo folder on the 

HyperStudio Program CD. Click Programming with HyperLogo 3.0 provides 

working examples of HyperLogo that demonstrate programming concepts 

ranging from simple Click Programming commands to a full-blown "HyperLogo 

Powered" game.  

 

The online tutorial is designed to serve two distinct purposes:  

 

1. Demonstrates and describes many of the most basic HyperLogo concepts 

2. Provides a variety of ready-to-use scripts 

 

This means that you can learn about the Logo programming processes driving 

these scripts, or you can simply copy and paste scripts into your own stacks with 

little or no modification.  
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The four main areas of interest covered in Click Programming with HyperLogo 

3.0 are: 

 

Navigation 

Manipulating Text 

Manipulating Objects 

Turtle Graphics 

 

Each of these areas is divided into subsections. Subsection 1 and 2 demonstrate 

the use of Click Programming commands and Parameter Pickers. If you're 

feeling a bit overwhelmed by the thought of learning a whole programming 

language, this is the place to start. Here you will find examples of how to point 

and click in HyperLogo to make things happen. 

 

Subsection 3 explores building simple procedures in the HyperLogo Script 

window. This is the next level in learning to program with HyperLogo. By 

combining several commands you will be able to create functions. Subsection 4 

provides examples of more complex scripts that use several lines of code. Many 

of these complex procedures can be copied and pasted into your own stacks with 

little or no modification.  

 

Subsection 5 of each area is a miniature application. Mini-application stacks 

indicate the highest level of programming covered in this tutorial. These stacks 

do not have all the text descriptions about the HyperLogo being used on every 

card. Instead they provide examples of incorporating many different scripts in a 

meaningful way. Play along, and then look at the Logo code, including the 

comments. 

 

Click Programming with HyperLogo 3.0 also includes a two-player question and 

answer game named 20 Answers. This game is a ready-to-use template, 
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complete with instructions for customizing new games with your own questions, 

answers, and categories. You do not need to understand how all the HyperLogo 

scripts work in order to create new games. 

 

Additionally, you will find a Quick Reference section with frequently used 

HyperLogo scripts for tasks such as creating alert dialogs, setting field text to 

display the current time and date, and special effects for your graphic and text 

objects.  

 

 

Other Logo Resources 
 

The Internet is a great resource for information on Logo and HyperLogo. Here 

are a few sites to get you started. 

 

HyperLogo listserv. Subscribe at: 

http://www.hyperstudio.com/resource/profdev/listserv.html 

 

HyperStudio User Forum 

http://hyperstudio.hyperstudio.com/cgi-bin/dnewsweb.exe 

 

LOGO-L listserv. Subscribe at: 

http://el.www.media.mit.edu/groups/logo-foundation/internet.groups.html 

 

Logo Foundation 

http://el.www.media.mit.edu/groups/logo-foundation/  

 

ISTE - International Society for Technology in Education 

http://www.iste.org/ 
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Chapter 4 
Installing HyperStudio 4.0 

 
Installation Instructions for Windows: 
 
  

1) Insert the 
HyperStudio CD into 
your CD-ROM drive. A 
screen showing the 
program name will 
appear. This is called 
the splash screen. 

 
If the install program 
does not start, find 
Hssetup.exe on your 
CD-ROM drive and 
double-click on it to 
begin the install. 
Alternately, you can use 
the Windows Start 
button, select Run… 
and type in 
D:\Hssetup.exe (where 
D is your CD-ROM 
drive) and select OK. 

 
 
  
2) A message will 

appear that the 
installer program is 
searching for certain 
programs.  
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3) The HyperStudio 
v.4 End User License 
Agreement will display. 
Use the scroll bar to 
view more of the 
agreement. Select I 
Disagree or I Agree. 

 

  
 
TIP#1: A button with a darkened border is considered the default selection when 
the Enter key is pressed. 
 
TIP#2: The underlined letters on the buttons identify the shortcut keys used to 
select the button instead of using the mouse. 
 
  

4) If you should 
decline the agreement 
or cancel out of the 
forthcoming dialog 
boxes, a confirmation 
dialog will appear. 
Select Resume or Exit 
Setup. 
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5) A dialog will 
appear that welcomes 
you to the program. 
The date the program 
was released and the 
version number are 
also displayed on this 
dialog. Select Next or 
Cancel. 

 

  
6) A dialog will 

appear giving you 
options for installing 
the program. The easy 
option lets the installer 
do all the work. It will 
even launch the 
QuickTime and 
Acrobat Reader 
installer programs if 
they are missing or are 
older versions. The 
custom option lets you 
decide what to install 
on your hard drive. 
Select Easy or 
Custom. Then select 
Back, Next, or 
Cancel. 
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EASY OPTION 
 

 
 

7) A dialog will 
appear letting you 
know that the installer 
is ready to copy the 
necessary files, 
including some fonts, 
from the CD to your 
hard drive. Select 
Back, Next, or 
Cancel. 
 
 

 

  
8) A dialog will 

appear that shows you 
the progress of the 
installation. To stop the 
installation select 
Cancel. 
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9) A dialog will 
appear that lets you 
know the installation of 
HyperStudio has been 
completed. Select 
Finish. 
 

 

 
NOTE: If QuickTime 4 or Acrobat Reader 4 do not exist on your computer, 
installers for these products will automatically start. Just follow each of the prompts 
to complete these installations.   
 
  

CUSTOM OPTION  

10) A dialog will 
appear for you to 
identify the directory 
where you want 
HyperStudio installed. 
A default directory is 
shown but can be 
changed using the 
Browse button. Select 
Back, Next, or Cancel. 
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11) A dialog will 
appear for you to 
select which 
components to install. 
Click in the box next to 
each component you 
wish to install. Disk 
space required and 
remaining are also 
displayed on the 
dialog. Select Back, 
Next, or Cancel.            
                                

  
12) A dialog will 

appear for you to 
identify the program 
manager group where 
you want HyperStudio 
icons to be placed. The 
icons will show up 
under the Start 
Menu>Programs 
selection of folders. A 
default folder name is 
shown but can be 
changed. Select Back, 
Next, or Cancel. 
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13) A dialog will 
appear asking if you 
would like a shortcut 
placed on your 
desktop. The default is 
yes and is shown by 
the checkmark in the 
box next to the reply. 
Select Back, Next, or 
Cancel. 

  
14) A dialog will 

appear letting you 
know that the 
installer is ready to 
copy the 
necessary files 
from the CD to 
your hard drive. 
Select Back, Next, 
or Cancel. 

 

  
15) A dialog will 

appear that shows you 
the progress of the 
installation. To stop the 
installation select 
Cancel. 
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16) A dialog will 
appear that lets you 
know the installation of 
HyperStudio has been 
completed. Select 
Finish. 

 
 
 

  

TO START THE PROGRAM: 
  

1) Locate the shortcut 
that was created on 
your desktop. Double-
click the icon to start 
the program                

-- or --                 
go to the Windows 
start menu and select 
Programs. Select 
HyperStudio or the 
name you specified 
during a custom 
installation. Then 
select HyperStudio 
4.0. 
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4) A registration 
dialog will display upon 
the first launch of the 
newly installed 
HyperStudio program. 
Enter your name and the 
registration number for 
the product. You can find 
the number (15 
characters in length) on 
your current HyperStudio 
4 license agreement.  
Select Cancel or OK. 
 
If you cannot locate your 
registration number, 
please call Knowledge 
Adventure Customer 
Service at 800-545-7677. 
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For Macintosh 
 
  

1. Insert the 
HyperStudio CD into your 
CD-ROM drive. A 
HyperStudio CD icon will 
appear on your desktop. 

 

  
2. Double-click the 

HyperStudio CD icon to 
open the disk, if 
necessary. Find the 
HS4Installer. 

 

 
  

3. Double-click the 
HS4Installer icon to begin 
the installation.  
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4. The first screen of 
the installer program 
appears. This is called 
the splash screen. Select 
Continue. 

  
5. The HyperStudio 

v.4 End User License 
Agreement will display. 
Use the scroll bar to view 
more of the agreement. 
Select Print, Save As, 
Decline, or Accept. 
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6. The HyperStudio 
Read Me file will display. 
Use the scroll bar to view 
more of the text. Select 
Print, Save As, or 
Continue. 
 

  
EASY INSTALL 
 

 
 
 
 
 

7. A dialog will 
appear for installing the 
program. Choose the 
Easy Install. You can also 
select the location where 
the files will be installed 
or view the Read Me file 
by selecting the Read 
Me… button. Select Quit 
or Install to continue. 
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8. A dialog will 
appear that shows you 
the progress of the 
installation. 
 

  
9. A message letting 

you know that the 
installation was 
successful will appear. 
Select Quit to exit the 
installation program. 

 

 
You’re done! 
 
(Other installation programs such as QuickTime will launch if the HyperStudio 
Installer program determines that you need these programs. Just follow the 
prompts to complete the installation(s).) 
  
 
CUSTOM INSTALL 
 

 
 
 
 
 

1) A dialog will 
appear giving you options 
for installing the program 
along with disk space 
information. Choose the 
Custom Install. Select 
which components to 
install by clicking on the 
check boxes. You can 
also select the location 
where the files will be 
installed. Select the Read 
Me… button to view the 
Read Me file Select Quit
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Read Me file. Select Quit 
or Install to continue. 
  

2) A dialog will 
appear that shows you 
the progress of the 
installation. 
  

  
2. A message letting 

you know that the 
installation was 
successful will 
appear. Select 
Quit to exit the 
installation 
program. 

 
You’re done! 
 
(Other installation programs such as QuickTime will launch if the HyperStudio 
Installer program determines that you need these programs. Just follow the 
prompts to complete the installation(s).) 
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TO START THE 
PROGRAM 

 

  
1) Double-click the 

HyperStudio 4.0 icon to 
start the program. 
  

 
  

2) A registration 
dialog will display upon 
the first launch of the 
newly installed 
HyperStudio program. 
Enter your name and the 
registration number for 
the product. You can find 
the number (15 
characters in length) on 
your current HyperStudio 
4 license agreement.  
Select Cancel or OK. 
 
If you cannot locate your 
registration number, 
please call Knowledge 
Adventure Customer 
Service at 800-545-7677. 
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Uninstall Instructions for HyperStudio v.4 
 
For Windows: 
 
  

1) Click the Start button 
on the task bar.  
Highlight Settings, then 
click Control Panel.  
Click the Add/Remove 
Programs Icon.  

 
  

2) A dialog will appear 
with HyperStudio 4 
listed. 
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3) A dialog will appear 
that welcomes you to 
the uninstall program as 
well as giving you 
options for uninstalling 
the program. The 
automatic option lets the 
uninstaller do all the 
work. The custom option 
lets you decide what to 
uninstall from your hard 
drive. Select Automatic 
or Custom. Then select 
Next or Cancel.  
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AUTOMATIC OPTION 

1) A dialog will appear 
letting you know that the 
uninstaller is ready to 
remove the HyperStudio 
4.0 program from your 
hard drive. Select Back, 
Finish, or Cancel. 

 

  
2) A dialog will appear 
that shows you the 
progress of the uninstall 
program. To stop the 
uninstall select Cancel. 

    

  
3) If there are any 
residual files left in a 
HyperStudio folder, 
inspect them before 
deleting the files and the 
HyperStudio folder. 

 

  
You’re done!  
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CUSTOM OPTION  

1) A dialog will appear 
allowing you to select 
which files to remove. 
Use the Select All 
button to select all the 
files or click to highlight 
each file you want to 
select. To de-select a 
file, click again to 
remove the highlight or 
use the Select None 
button to de-select all 
the files. Then select 
Back, Next, or Cancel. 

 

  
2) A dialog will appear 
allowing you to select 
which directories to 
remove. After making 
your selection(s), select 
Back, Next, or Cancel. 
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3) A dialog will appear 
allowing you to select 
which registry keys to 
remove. After making 
your selection(s), select 
Back, Next, or Cancel. 

 

  
4) A dialog will appear 
letting you know that the 
uninstaller is ready to 
remove the HyperStudio 
4.0 program from your 
hard drive. Select Back, 
Finish, or Cancel. 
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5) A dialog will appear 
that shows you the 
progress of the uninstall 
program. To stop the 
uninstall select Cancel. 

 

  
6) If there are any 
residual files left in a 
HyperStudio folder, 
inspect them before 
deleting the files and the 
HyperStudio folder. 

 

 

  
You’re done!  
 
  
For Macintosh: 
 
 
Simply drag the HyperStudio folder into the trash. Don’t forget to empty the trash 
to free up space. 
 
That’s it! 
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Chapter 5 
HyperStudio Step-by-Step Tutorial 

 
A Brief History of Writing 

 
 
Here are step-by-step instructions for using HyperStudio to build a five-card 
project that creates a timeline about the history of writing. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
Create your first HyperStudio project! 

 
 

��Navigate menu features and learn to create cards that build into stacks.   
��Discover how to use text and graphics. 
��Learn how to add images and sounds from peripheral equipment such as 

scanners and CD-ROMs, clips from QuickTime movies, and hyperlinks. 
 
 
 

When you see this icon, the information enclosed in the box to its right is 
about the history of writing. You may choose to read the information or 
you may skip it. Skipping it will not affect the tutorial materials.   
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Section 1  Moving within the Menu 

 
Section 1 should take approximately 45 minutes to complete. 
 
Explore these essential features: 
▶ Project Overview 
▶ New Stack 
▶ Dialog Box 
▶ Browse Tool and Edit/Selector Tool 
▶ Preferences 
▶ “Drag-and-Drop” 
▶ Import Background 
▶ Media Window 
▶ Paint Text Tool 
▶ Moving Painted Text 
▶ Four-Headed Arrow Cursor 
▶ Add Clip Art 
▶ Double-Headed Arrow Cursor 
▶ Lasso Selector Tool 
▶ Practice with Tools and Colors 
▶ Add a New Card 
▶ Erase Background 
▶ Add a Button 
▶ Actions Dialog Box 
▶ Transitions Dialog Box 
▶ Save Stack 
▶ An Extra Challenge – Scale and Flip an Image 
 
Project Overview 
 
Here is what your first card might look like when completed.  It’s titled, 
“Prehistory: Lascaux Cave Paintings,” from the stack you will create called, “A 
Brief History of Writing.” 
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New Stack 
 
Once you have HyperStudio installed, you are ready to begin.  HyperStudio 
opens with the Tip of the Day! stack - handy notes on shortcuts and features.  
These tips will mean more to you after you finish the tutorial.   
 

 
 

Be sure to click the Home Button in the lower right corner. The Home Stack is 
designed to acquaint you with HyperStudio’s features. The Discover stacks 
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include Student Projects, Teacher Lessons, and User Projects. The Learn stacks 
include The Essentials, HyperLogo, Easy Effects, and the Content Library. The 
Excel stacks include Workshop in a Box and links to websites. 
 
Dialog Box 

 
Are you ready to begin?  On the Tip of the Day! page or the Home Stack, click 
the New Stack button.  Or, click the File menu and select New Stack. 
IMPORTANT: If the File menu is not present, type Ctrl M or Command M. 
 
A dialog box will appear on the screen.  Dialog boxes help you through complex 
procedures.  Read the contents of this one, and then click Yes.  HyperStudio 
creates a new card for you to begin your project.  Notice the top menu reads, 
Untitled - Card 1. 
 

 
 
 
Browse Tool and Edit/Selector Tool 
 
Notice your cursor.  The small hand is called the Browse tool. The person who 
views your stack will use this tool. You will also use the Browse tool to check 
various card and stack actions.  Click the word Tools on the menu bar.   
 
The arrow icon located on the right is called the Edit/Selector Tool.  You will use 
this tool for creating your stack. 
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Shortcut:  You will be switching between the Browse tool and the Edit/Selector 
tool often as you work on your stack.  Try the keyboard shortcut, Shift Tab, to 
toggle back and forth quickly between the Browse and Edit tools.  
 
Preferences 
 
Click the Edit menu and select Preferences.  The Preferences dialog box will 
appear.  Under Program preferences, make sure that the box is not checked for 
I’m an experienced HyperStudio user.  HyperStudio will give you helpful prompts 
while you’re learning the program.  Be sure the rest of the options are checked or 
left unchecked as shown in the following illustration. 
 

 
 
Choose OK to return to the card. 
 
“Drag-and-Drop”  
 
Drag-and-Drop is a term for a simple method of moving text and graphics. The 
actual steps are to click and hold the mouse on a selected or highlighted object, 
drag it to a new location, and release the mouse. You will use this method in 
many HyperStudio functions.  Use it first to move the Tools palette from the 
menu bar to the side of your card where it will remain open for easy access.  The 
Tools palette is a collection of basic tools used to create all sorts of visual effects.  
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To drag-and-drop the toolbox where it is easy to use: 

1. Move the cursor over the word Tools on the menu bar, click, and hold 
down your mouse button as you drag the box.  A copy of the Tools palette 
will tear away. 

 
2. Drag the Tools palette to the left side of the card.   
 
3. Release and drop the Tools palette into position.   

 
That’s it!  Drag-and-drop! 
 
Now do the same with the Colors palette, but set it to the right of the card. 
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To close either palette, click on its upper left corner. 
 
Now is a good time to practice using the shortcut, Shift Tab, to switch back and 
forth between the Browse and Edit tools.  Notice how the selected tool becomes 
highlighted on the Tools palette. 
 
Import Background 
 
The options for backgrounds are vast—you can use a plain color background or 
import backgrounds and clip art images from HyperStudio’s collection of art. 
 
For your first card, you will import a background from the Media Library. 
 

1. Click on the Options menu and select Show Media Window. 
 

2. Select Backgrounds in the pull-down box, and check the Preview box to 
open the preview window. 

 

 
 

3. Locate the CaveInterior.bmp file and click on it.  A preview will appear in 
the window. 

.  
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4. Using the Edit/Selector tool (the arrow), depress the Alt/Option key and 

drag-and-drop the Cave Interior file (the words, not the preview picture) 
from the Media Window onto the card.  The Drop Options dialog box 
appears.   

 
 

5. Select Import background… and choose OK.  Another dialog box opens. 
 

 
 

6. Choose Yes to resize the image to fit the card. 
 

7. The background image will appear on the card. 
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Your background is ready for you to begin. 
 
Media Window 
 
To move the Media Window so you can see your card better, click on its Title bar 
and drag-and-drop it to the side of your card.  Or, minimize the Media Window by 
clicking on the upper left corner of the box. Select minimize from the drop-down 
menu that appears, and the Media Window will be stored as a button (Media 
Browser or Media Window) on the Tool Bar at the bottom of your computer 
screen. To minimize the Media Window in Macintosh, click on the upper right 
corner of the Media Window.  To restore it in Windows, just click on it and the 
window will appear in the position it was in before it was minimized. To restore it 
in Macintosh, click on the top left corner of the Media Window Title bar. 
 
 
 
 
 
 
 
 
 
 
 
 

Cave as Canvas… Historians speculate that the process of 
painting was, in itself, a ritual in which the cave artists engaged.  
They may also have painted to record information or express 
themselves. 
 
You are going to create a simulation of a cave painting.  How 
much easier it is to apply images to a computer screen than to a 
damp, dark cave wall! 
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Paint Text Tool 
 
The Paint Text tool (T) paints text on your card.  Painted text becomes a 
permanent part of the background.  You can choose from a variety of fonts, 
sizes, and colors for your text.  You will use the Paint Text tool (T) to give your 
card a title. 
 
To use the Paint Text tool (T): 

1. Click Format and select Text Style…. 
 

 
 

2. From the Text Style dialog box, we selected these text characteristics 
(you may choose any others): 
 

a. Font  Schoolboy 
b. Font Style Plain  
c. Font size 14 or 16 
d. Text color Dark brown 

 

 
 

3. Choose OK. 
 

4. Click on the Tools menu and select the Paint Text tool (T). 
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5. The Edit/Selector tool (the arrow) turns into an I-beam cursor when it is 
moved onto the card.  Place it to the left of center on the card and type: 

 
PREHISTORY 
Lascaux Cave Paintings 

 
If you make an error or wish to change the font style, color, or size, use the 
backspace key to correct mistakes, or click Format and select Text Style before 
clicking away from your text.  When you click away from the text, it becomes 
permanently painted to the background.   
 
Moving Painted Text 
 

1. From the Tools menu, select the Square Selector tool.  (This looks like a 
square made of dotted lines.) 

 
2. The cursor becomes a crosshairs.  Position it in one corner of the title, 

then click and drag it diagonally across the title.  A square of dotted red 
lines will appear.  Release when the square outlines the title.  The dotted 
red line surrounding the image indicates that it is “selected” or 
“highlighted.”  This means that an object or image (in this case, text) on 
the card may be moved, resized, or edited.   

 
Four-Headed Arrow Cursor 
 

3. Move the cursor over the title.  The four-headed arrow cursor appears.  
Use this cursor to reposition the title by dragging it to the top left corner of 
the card and dropping it in place. 
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4. Move the cursor outside the dotted red lines and click.  Your title is now 
repositioned.  Use this method to move any part of the background. 

 
Add Clip Art 
 
Now that you have a background, a title, and your Tools palette is placed where 
you want it, it is time to learn about adding images to your card.  The Media 
Library contains a variety of clip art images, which you can select, modify, and 
add to your card.  (You can import clip art from other files, too, by clicking File 
and selecting Add Clip Art.)  For your first card, you will select the image of a 
bison from the HyperStudio Tutorial folder to apply to the cave wall background. 
 

1. From the Tools palette, select the Edit/Selector cursor (the arrow). 
 
2. Restore the Media Window by clicking the Media Browser button on the 

Tool Bar at the bottom of the computer screen. 
 

3. Select Clip Art from the drop-down menu (be sure the Preview box is 
checked). 

 
4. Find the CaveBison.jpg file, depress the Alt/Option key, and drag-and-

drop the file onto the card. In the Drop Options dialog box, select Lasso 
the clip art and choose OK. Click outside the image to set it in place. 
(Minimize or move the window out of the way after use.)  
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Double-Headed Arrow Cursor 
 
Let’s make the bison larger.   

1. Select the bison using the Square Selector tool . 
 

2. Using the crosshairs, draw a box around the bison to select it (it will 
become surrounded by a dotted red line). 

 
3. Move the cursor to the corner of the selected image.  It will turn into a 

double-headed arrow cursor. 
 

4. Make the bison larger by pulling the double-headed arrow cursor in the 
corner away from the center of the image. 

 

 
 
Click outside the image to set it in place. 
 
Move the cursor onto the newly enlarged image (it turns into a four-headed 
arrow cursor) and click and drag the bison to the right side of the card. 

 
 

Lasso Selector Tool 
 
We are now going to move the bison to a different location on the card.  Use 
these steps any time you want to move clip art after you have set it in place. 
 

1. From the Tools palette, select the Lasso Selector tool (it looks like a lasso 
).  

 
2. While depressing the mouse key, draw an outline around the bison.   

 



 72

3. Release the mouse button.  The image of the bison is covered in flashing 
red lines, indicating it has been captured. 

 

 
 

4. Move the cursor over the image until the cursor turns into the four-headed 
arrow.   

 
5. Click the mouse, and drag-and-drop the bison to the lower right side of the 

cave. 
 

6. Click outside the image to set it in place on the card.  Your card should 
look something like this: 
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Note: While using any selector tool, if what you’re trying to do doesn’t work, click 
outside the image to deselect it. Click File, select Undo move, and try again. 
 
Practice with Tools and Colors 
 
Colors are selected from the Colors palette.  Click the Colors menu to open the 
palette.  This palette can be torn away and placed on your screen by using the 
same drag-and-drop method as for the Tools palette. 
 
 
 
 
 
 
 
 
 
 
 
 
The Colors palette offers a wide range of colors and pattern options for your 
work.  Plus, no sticky wax or tallow binders are necessary to get your paint to 
stick to your “cave wall!”  
 
To apply color and draw with the Spray Can tool: 

1. Click the Colors menu to view the palette if it is not open on the screen.   
 

2. Place the Edit/Selector cursor on a color (try medium brown) and click to 
select it. 

 
3. From the Tools menu, click on the Spray Can icon. 

 
4. The cursor turns into a spray can.  Move it to the lower left corner of the 

card, and press the mouse to deliver a spray of paint.   
 
Use the Spray Can tool to freehand draw another bison like the one you obtained 
from Clip Art.  Experiment with style by depressing the mouse key and moving 
the mouse to apply color evenly, or pulse the mouse key between moves to 
achieve a stippled effect.  Hold the can in place or move it back and forth while 
spraying to create dark and light layering effects. 
 
Add even more depth to your drawing by selecting a new color to layer over a 
previous one.  For instance, you might want to try layering reds and yellows on 
top of darker browns and blacks. 
 

Early Cave Artists… Historians believe that early cave artists 
might have applied pigment to the cave wall by using a spray 
technique.  Prehistory artists mixed their colors from minerals 
and natural oxides.  They used a natural palette of yellows, reds, 
blacks, browns, and violets—no greens or blues.  Archaeologists 
have found hollow bones stained with these pigments.  They 
believe that early artists blew through these hollow bones to 
spray colored paint onto the cave walls. 
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Bison, deer, antelope, and human figure drawings are common subjects of early 
cave paintings.  Try creating any of these subjects on your card.  Prehistory 
images were never on a ground line; they seem to “float,” so place your artwork 
anywhere you like! 
 
Take a few minutes to play with the draw tools.  Select different colors and 
practice drawing a bison using the Spray Can, Pencil, and Paintbrush tools.  To 
vary the Paintbrush, click Options and select Brush Shape to change the shape 
and thickness of the brush stroke. It doesn’t matter if it isn’t perfect – it’s cave art! 
Don’t forget, you’ll get better as you practice. 
 

 
 
If you wish to remove any of your art, go immediately to the Edit menu and select 
Undo Painting.  This will reverse the most recent procedure performed.  Or, use 
the Eraser tool.  It’s white by default, but its color can also be selected.  Go to the 
Options menu and choose Set Eraser Color.  It will now “erase” with the 
selected color.   
 
Caution:  Be careful! The Eraser tool will erase any background images, 
including clip art and painted text! 
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Add a New Card 
 
You have completed the art for the first card of your stack, “A Brief History of 
Writing.”  Now you need to add a Button so you can move easily to the second 
card in your stack.  The first step is to add the second card.   
 
From the Edit menu, select New Card.  You are now on Card 2 of your stack. 
Notice the card’s Title bar says, “Untitled – Card 2.”   
 
Erase Background 
 
If you previously selected a color for the Eraser tool, that color will be the 
background color of Card 2.  The color can be changed by clicking Edit, 
selecting Choose Erase Background, selecting white for the new color, and 
choosing OK. 
 

Cave Artists’ Painting Techniques… Another theory of how 
cave artists painted is that they punched small holes in a thin 
animal skin that held vegetation fibers soaked with pigment.  
When placed against the cave wall, this painting tool allowed 
small amounts of pigment to ooze out.  Using a sponge-print 
technique of layering pigment may have given artists more 
control over their medium. 
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Move back to Card 1 by clicking Move and selecting Back.  You are now on the 
first card. 
 
Shortcut:  To move quickly back and forth between cards, use 
Control/Command > to move forward and Control/Command < to move back. 
 
Add a Button 
 
In HyperStudio, users can or navigate from card to card and stack to stack by 
clicking a Button.  Buttons, however, offer many more features than simply 
moving the viewer through a stack, as you shall later see. 
 
1. Click the Objects menu and select Add a Button.   

 
2. A Button Appearance dialog box will appear.  

To choose a Button Type: 
a. Select number 1 from Type palette (the default shape). 
b. Name the Button by typing the word “Next” in the name field box in the 

Button Appearance dialog box.   
c. Color the Button by selecting yellow for the name and dark brown for the 

background of the Button.   
d. In the bottom left corner of the Button Appearance dialog box, check 

the Show Name and Highlight boxes.   
e. Choose OK. 
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3.  A prompt will give you directions about where to place your Button and how to 
locate the Button on your card.  Choose OK. 

 
4.  The Button you just created will appear in the center of your card, outlined 

with dotted red lines.  Place the cursor on top of your newly created “Next” 
Button.  The four-headed arrow cursor will appear.   

 
5. Using the Drag-and-Drop method, position the image near the bottom center 

of the card.  Click outside the Button image to set the Button in place.  This 
opens the Actions dialog box. 

 
 
 

 



 78

 
Actions Dialog Box 

 
The new button has an appearance and position on the card.  Now, it needs 
some action! 
 
1. The Actions dialog box has two columns: Places to Go, and Things to Do. 

 

 
 

2.  From Places to Go, select Next card.  This will open the Transitions dialog 
box.   

 
 
Transitions Dialog Box 
 
The Transitions dialog box has options that will determine how your 
HyperStudio cards will open or close (e.g., fade, come in from the left, etc.).  You 
can also choose the speed at which you want the card to open or close.   
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1.  Experiment with the different transition and speed effects by choosing Try It. 
When you have achieved the effect you want and made the settings, choose 
OK. 

 
2.  In the Actions dialog box, choose Done.   
 
Try out your Button.  Remember, the Edit/Selector tool will not activate card 
features.  You must click Tools and select the Browse tool, (the hand.)  Then, 
click on the Button to go to Card 2.  Use the Move menu to return to Card 1 or 
use the shortcut, Control/Command <. 
 
Save Stack  
 
It’s a good idea to save your work frequently. 
 
To save your two-card stack: 

1. Click the File menu and choose Save Stack. 
 

2. The Save As dialog box appears.  Name the stack HistoryofWriting.  Save 
the stack in the HyperStudio directory, in the MyStacks folder. Double-
click the folder to open it, and save your stack there, or right-click your 
mouse and create a new folder.  Be sure to remember where you put your 
stack! 

 
3. Click Save. 
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Tip: If you wish to save a copy of the stack to another location, click File and 
select Save Stack As…, and follow the steps above.  If you wish to save your 
stack under another name, you can use this same method. 
 
An Extra Challenge – Scale and Flip an Image 
 
This addition to the first card of the stack is optional.   
 
Add a Clip Art Cave Painter 
 

1. Using the techniques learned in this section, import the Caveman.bmp 
image from the Clip Art folder in the Media Library by using the Media 
Window.  Drag the file onto the card while depressing the Alt key.   

 
2. In the Drop Options dialog box, select Crop the clip art… and choose OK.  

 
3. In the Clip Art dialog box, double click the Square selector tool to select 

the caveman and choose Scale and Rotate. 
 

4. In the Scale and Rotate dialog box, set the scale factor to 80% and 
choose OK. 

 
5. Select the scaled caveman by double clicking the Lasso selector tool and 

choose OK. The caveman appears in the middle of the card, still selected. 
 

6. To flip the caveman (it’s still selected), click Edit and select Effects. 
 

7. Select Flip Sideways. 
 

8. Use the four-headed arrow cursor to place the caveman anywhere you 
like on the card. 
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The Effects command has many different options for changing the appearance of 
images.  Try some of the others, like Scale and Rotate, Flip Upside Down, or 
Replace Colors. 
 
You may Quit HyperStudio and take a break, or continue with Card 2 now. 
 
To recap, in Card 1 you 
• Created a new stack 
• Imported a background image using the Media Window 
• Added a title using Painted text and moved it 
• Imported, enlarged, and moved a clip art image 
• Explored using the paint tools 
• Added a new card (Card 2) 
• Added a Button to move to Card 2 
• Scaled and rotated an image 
• Gave the stack a name and saved it 
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Section 2  Creating with Cards: Starting with Stacks 
Section 2 takes approximately 1 hour to complete.  
Explore these essential features in this tutorial: 
 
▶ Open a Stack 
▶ Add a Background  
▶ Edit to Make a Clip Art Border 
▶ Use the Paint Bucket Fill Tool 
▶ Add More Clip Art 
▶ Scale an Image 
▶ Use the Magnifying Tool 
▶ Import an Image from the Media Library 
▶ Use the Rounded Rectangle Tool 
▶ Copy and Resize Art 
▶ Create Navigation Buttons from Background Images (Clip Art) 
▶ Add Icons to Buttons 
▶ Add Sound to a Button 
▶ Add a Text Object 
▶ Add a Graphic Object 
▶ Rotate an Image 
▶ Add Ready-Made Animation 
▶ Add Sound to a Graphic Object  
▶ Save Stack As… 
 
Project Overview 
 
Here is an example of how your second card, “Ancient Times: Egyptian 
Hieroglyphics,” could look when you are finished with this section. Remember, 
your card can look any way you want. 



 83

 
 
 
Open a Stack 
 
To open your stack, click on the Open Stack Button on the HyperStudio Home 
Page or choose the File menu and select Open Stack.  Do this every time you 
return to the tutorial after exiting the program.  
 
A dialog box may ask if you are sure you want to do this.  Click Yes.   
 
The Please Select a Stack dialog box appears.  If you saved your Timeline 
stack in the HyperStudio folder, it will appear after the folders, to the right.  If you 
saved it in a folder such as MyStacks, double-click the folder icon to see your 
stack name and icon. 
 
Select the stack and click Open or double-click the stack to open it. 
 
Card 1 will appear on your screen.  Click Tools, select the Browse tool, and click 
on the Next Button to move to the second card in your stack. 
 
HistoryofWriting or HistoryofWriting.stk - Card 2 appears on the Title bar above 
the card. 
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Add a Background  
 
Some of the clip art in the Media Library comes surrounded by a border.  You 
may want to add just the border, but without including all other clip art in the 
image. 
 
To add a clip art border to Card 2: 

1. Click on the Options menu and select Show Media Window. 
 

2. Select Clip Art in the pull-down box, and check the Preview box to open 
the preview window. 

 
3. Locate the EgyptianArt.jpg file and click on it.  A preview will appear in the 

window. 
 

4. Using the Edit/Selector tool, drag-and-drop the EgyptianArt file onto the 
card while depressing the Alt/Option key.   

 
5. In the Drop Options dialog box that appears, select Import background… 

 
6. Choose Yes to resize the image to fit the card. 

 
7. The background fills the card. Minimize or move the Media Window out of 

the way. 
 
Edit to Make a Clip Art Border 
 

8. To cut out the interior images, click the Tools menu and select the Square 
Selector tool.  Set the crosshairs cursor just inside the upper left corner of 
the border, and drag the mouse to just inside the bottom right corner of the 
border.  A dotted red line will enclose all of the artwork to be removed from 
the card. 
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9. Now click Edit and select Cut (Ctrl X or Command X), or press the Delete 
key to remove the artwork.  The clip art border remains on the card.   

 
Use the Paint Bucket Fill Tool 
 

10. Finally, use the Paint Bucket Fill tool to fill the center of the card with the 
lightest shade of gray on the Colors palette.  Click the Colors palette and 
select the color, then click on the Paint Bucket Fill tool on the Tools 
palette.  Position the Fill tool anywhere in the center area and click.  It will 
fill with light gray!   

 
Your card will look like this: 
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Now that the background and border are in place, let’s title the card “Ancient 
Times: Egyptian Hieroglyphics.” Follow the steps you learned for Card 1 to make 
a title.  Choose any font, size, and color text you desire. Remember, painted text 
becomes a permanent part of your background. Before you paint on the text, you 
should save the stack.  That way, if you make an error, just exit, don’t save 
changes, and reopen your stack.  Then paint again. 
 

Cuneiform and Hieroglyphs… Scribes carved and painted tomb 
walls to tell the stories of rulers and the history of their civilization.  
Cuneiform was probably evolved from the picture writing of the 
Sumerian people.  This language was based on combinations of 
wedge shapes carved in stone.  The earliest known cuneiform 
inscriptions were found in the lower Tigris-Euphrates Valley, and 
dated from about 3000 BC.  The most recent example of a scribe’s 
handiwork was written about A.D.  75. 
 
Hieroglyphs are symbols and signs called ideograms.  These picture
forms represent an object, action, or idea.  For instance, a symbol of 
the sun could represent ideas of time or weather.  Egyptians 
advanced this early picture-writing system to a form of writing known
as hieroglyphics, which were written on tomb walls, monuments, 
papyrus, and other Egyptian artifacts.  For centuries, this form of 
picture writing was a mystery to recent cultures because no one 
could decipher the symbols.  The first event that led to cracking the 
code occurred when Napoleon’s soldiers discovered the Rosetta 
stone.   
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Add More Clip Art: French Soldiers and the Rosetta Stone 
 
On Card 2 you will add images of French soldiers and ancient picture writing.  
Geometric patterns known as cuneiform are the earliest form of Egyptian writing. 
 
 
 
 
 
 
 
 
 
 
 
 

1. Find the FrenchSoldiers.bmp file in the Clip Art section of the Media 
Window. 

 
2. Using the Edit/Selector tool, drag-and-drop the file on the card while 

depressing the Alt/Option key to open the Drop Options dialog box.  
Select Crop the clip art… and choose OK. 

 
3. Use the Square Selector tool to capture the image of the French soldiers 

in the Clip Art dialog box.  Choose Scale and Rotate. 

The Discovery of the Rosetta Stone… In 1799, Napoleon 
ordered a troop of his engineering corps to clear a section of land
for Fort Julien.  In the process, his soldiers found a huge black 
stone half buried in mud on the bank of the Nile near the village 
of Rashid, which Europeans translated as “Rosetta.”  This 
impressive stone was covered with three distinctive bands of 
curious markings and symbols.   
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Scale an Image 
 

 
 
 

4. In the Scale and Rotate dialog box, enter 75 in the Scale factor window 
and choose OK. 

 
5. Now capture the new smaller image in the same window, by double 

clicking the Lasso Selector tool in the Clip Art dialog box and choose OK. 
 

6. The selected image is now encircled by dotted red lines and has been 
transferred to Card 2. 

 
7. Move the cursor over the image you transferred.  It changes to a four-

headed arrow cursor.  Reposition the image of the soldiers to the bottom 
right corner of Card 2. 

 
8. Click outside the image or press Enter to set the image in place. The 

dotted red lines disappear, indicating that the picture of the French 
soldiers discovering the Rosetta stone has been added to Card 2. 
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9. Repeat the procedure described above to insert an image of the Rosetta 
stone from Clip Art Library.  Drag the RosettaStone.bmp file from the 
Media Window to the card while depressing the Alt/Option key.  When the 
Drop Options dialog box opens select Crop the clip art… and choose OK. 

 
10. Capture the image of the Rosetta stone using the Square Selector tool 

and choose Scale and Rotate. 
 

11. When the Scale and Rotate dialog box opens, change the number in the 
window to 40% and choose OK. 

 
12. Use the Lasso Selector tool to capture the edited image of the Rosetta 

stone and choose OK.  Move the Rosetta stone to the lower left corner of 
the card and click outside it to set it in place. 

 

The Rosetta Stone… It is believed that the Rosetta stone had 
been part of a wall built around 200 B.C. After the discovery of 
the stone, it was shipped and stored in Cairo. As part of the 
spoils of the Napoleonic Wars, it was later stolen and moved to 
England. Today the Rosetta stone is a centerpiece at the British 
Museum in London. This huge stone is a thick slab of black 
basalt, weighs three-quarters of a ton, and measures 3’ 9” by 2’ 
4”. 
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Solving a Riddle of the Ages… The language and history of ancient 
Egypt puzzled scholars for hundreds of years.  It wasn’t until 1822 
that the symbols and pictures were deciphered by Jean Francois 
Champollion, a French scholar who spent most of his life trying to 
decipher the writing on the Rosetta stone.  The clue that made this 
possible opened up the entire language of the ancient Egyptians.   
 
Examining the Rosetta stone…The Rosetta stone displays three 
bands of writing, each of which describes the deeds of the King of 
Egypt, Ptolemy V Epiphanes, during his reign from 203-181 B.C.  
Each band is written in a different language:  hieroglyphics, Demotic, 
and Greek. 
 
The top row is hieroglyphs, an early form of an ancient Egyptian 
alphabet, and is made up of symbols that represent objects as well as
sounds.  The middle band of writing, Demotic, was a simpler, 
everyday kind of writing.  The bottom band of writing on the Rosetta 
stone is yet another translation of Ptolemy’s deeds.  This writing is in 
early Greek script.  Until 1822 no one could decipher the curious 
symbols and pictures, and little was known about early Egyptians.   
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Use the Magnifying Tool 
 
1. Click on Tools.  Select the Magnifying Glass tool.  The Magnifying Glass tool 

changes to a box cursor.  Move the box cursor over the image of the Rosetta 
stone you placed on your card. 
 

2. By clicking the mouse you can enlarge segments of the image by 200%, 
400%, and 800%.  A small window shows you the unmagnified size of the 
image.  Close this window by clicking the upper left corner, or move it out of 
the way by clicking on the top bar and dragging-and-dropping it at the edge of 
your screen. 

 
 
 
 
 
 
 
 
 
 
 
 
3. To return to the 100% normal view, continue to click the mouse or press the 

Escape key on your keyboard. 
 

 

The Names of Royalty… Champollion’s quest to decipher the 
stone was assisted by the famous British scientist, Thomas Young.  
By examining the symbols and making comparisons, Champollion 
and Young figured out that the names of ancient Egyptian royalty 
were designated in a special way.  Scribes either chiseled or drew a 
rounded rectangular outline, called a cartouche, around the names 
of royalty.  Even Cleopatra’s cartouche was inscribed on the 
Rosetta stone.   
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(Note the hieroglyphic band outlined by a rounded rectangle on the Rosetta 
stone.  This cartouche contains the clue that helped Champollion crack the 
code—the hieroglyphic symbols that represent Pharaoh Ptolemy’s name!) 

 
Champollion 

 
Another way to enlarge images on the card is to click Options and select 
Magnify.  This feature magnifies the contents of the entire card.  Choose 200% 
magnification. 
 
Look closely at the “code cracker.”  Select 400% or 800% magnification and 
practice zooming in to magnify the cartouche of Ptolemy.  In a following section 
you will use the Magnifying tool to edit images on a pixel level with the Paint tools 
allowing you to make very small changes to an image.  For now, just look at the 
enlargements of a cartouche.  Notice the rounded rectangle around Ptolemy’s 
name. 
 
Click on the Options menu, select Magnify, and choose 100% to return to the 
regular card view.   
 
Return to Tools and select the Browse tool (or use Shift Tab). 
 
Like the Egyptian scribes, you will draw a cartouche-like shape around Ptolemy’s 
name.  Instead of using a hammer and chisel, though, you will experiment with 
HyperStudio’s easy-to-use Rounded Rectangle tool. 
 
 
 
 
 
 
 

The Cartouche… Understanding the meaning of the cartouche 
allowed Champollion and Young to unlock the code and decipher 
the hieroglyphs.  Using the Greek text as a guide, they studied the 
position and repetition of proper names. They found the same 
names in the Egyptian text, and thus were able to learn the 
sounds of many of the Egyptian hieroglyphic characters. 
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Import an Image from the Media Library 
 
Now, to examine the cartouche in greater detail, import a full-size image of it from 
the Media Library. 
 

1. From Media Window, select the RosettaStone.bmp file.   
 
2. Drag the Rosetta stone file onto the card while pressing the Alt/Option 

key.   
 
3. In the dialog box, select Crop the clip art and choose OK.   
 
4. Using the Square Selector tool, capture Ptolemy’s cartouche from the 

center of the Rosetta stone and choose OK.   
 
5. Use the four-headed arrow cursor to move the cartouche to the lower left 

corner of Card 2 (on top of the Rosetta stone image). 
 

 
 

Next you will add a broad border around the cartouche. 
 
Use the Rounded Rectangle Tool 
 

1. Click the Options menu and select Line Size.   
 

2. From the Line Size dialog box select the medium width line.  Click OK. 
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3. Return to the Options menu and select Draw Centered.  This option 
allows you to place the cursor in the center of the image of Ptolemy’s 
cartouche, and draw from a center point instead of from a corner. 

 
4. Click on the Colors menu and select any color you like (we chose dark 

red).   
 

5. Click on the Tools menu and select the Rounded Rectangle tool.  The 
tools such as the Line tool, Pencil tool, Rectangle tool, Rounded 
Rectangle tool and the Oval tool are all used for drawing shapes on the 
background.   

 
6. Place the crosshairs cursor in the middle of the image of Ptolemy’s 

cartouche, and drag the cursor to a corner of the cartouche to fit around 
Ptolemy’s name.  Release the mouse to set the rounded rectangle border 
around the hieroglyphs representing Ptolemy’s name. 

 

 
 
Copy and Resize Art 
 

1. From the Tools menu, select the Square Selector tool.  Use the 
crosshairs cursor to capture the cartouche and its border. 

 
2. Click the Edit menu and select Copy (or Ctrl/Command C). 

 
3. Click the Edit menu again and select Paste (or Ctrl/Command V). 

 
4. Move the cursor back over the selected image.  As you move across the 

image you will note that the cursor changes to a four-headed arrow cursor. 
 

5. Move the copy of the cartouche to the bottom right corner of the card.   
 

6. To enlarge the copy, move the four-headed arrow cursor to a corner of the 
cartouche.  The four-headed arrow cursor changes to a double-headed 
arrow cursor.  Click and drag the corner out to enlarge the image. 
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Note: Another way to resize an image is to click Edit, select Effects, and then 
select Scale and Rotate.  To try it with this image, enter 150% in the Scale Factor 
window and choose OK. 
 
Move the cursor outside the dotted red lines and click the mouse to position the 
image. 
 

 
 

 
As you know, HyperStudio users move through cards and stacks by using 
Buttons.  Buttons are also used to activate multimedia elements like sound, 
video, animation, and other feature actions. 
 
In the last section, “Prehistory: The Lascaux Cave Paintings,” you designed a 
“Next” Button to move to the next card, “Ancient Times: Egyptian Hieroglyphics.” 
 
On that first card of the stack, “A Brief History of Writing,” you used a 
HyperStudio pre-designed Button shape from the Button Type palette.  Now, for 
the second card, design your own Buttons by using the Lasso Area Button to 
select a clip art image from the card’s background.   
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Create Navigation Buttons from Background Images (Clip Art) 
 

1. Click Objects and select Add a Button.  The Button Appearance dialog 
box will appear.   

 
2. From the Button Type palette, select the Lasso Area Button (number 8).   

 
3. Choose Position.  The card “Ancient Times: Egyptian Hieroglyphics” 

appears with the Lasso cursor. 
 

4. Locate the smaller cartouche of Ptolemy on the bottom left.  Draw around 
the cartouche of Ptolemy with the Lasso cursor.   

 
5. A prompt appears stating, “Your button shape has been defined.”  Note: 

The image you lasso must have a defined shape.  To change this image 
into a Button, choose OK. 

 
6. The Button Appearance dialog box returns.  In the bottom left of the 

Button Appearance dialog box, check Show Icon. 
 
Add Icons to Buttons 
 

1. The Icons dialog box opens.  Select the left-facing white arrow icon and 
choose OK. 

 

 
 

2. Close the Button Appearance dialog box by choosing OK 
 

3. The Actions dialog box appears.  Under Places to Go, select Previous 
Card.   

 
4. From the Transitions dialog box, select any transition and speed. Choose 

OK and then Done. 
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5. Change to the Browse tool by pressing Shift Tab to check your new 

Button. 
 
Clicking this Button should transport you to Card 1.  Now go to Card 2 to create a 
Button that moves you to Card 3; achieve this by repeating the steps above and 
using the larger cartouche from the bottom right corner.  Select the right-facing 
white arrow from the Icons dialog box.  In the Actions dialog box, select Next 
Card.  Make selections in the Transitions dialog box. 
 
Add Sound to a Button 
 
After the Transition has been chosen, select Play a sound… from Things to Do in 
the Actions dialog box.  The Digital Audio Deck dialog box will automatically 
open. 
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1. Select EXITNOTE.WAV or any other choice from the Sample sounds 
shown in the window. Choose OK. 

 
2. The Actions dialog box reappears.  Choose OK, then Done. 

 
You now have two buttons, one to go to the next card, and one to go back.  You 
have chosen the shape of your button, and added a sound effect. Take a deep 
breath; you’re on the home stretch. 
 

 
 
Now, in preparation for continuing your stack, add Card 3 by using the new card 
shortcut, Ctrl N or Command N.  Return to Card 2 by using the shortcut, Ctrl < or 
Command <.  Select the Browse tool to click the Button on Card 2 that advances 
you to the next card in the stack. 
 
To conclude the card “Ancient Times: Egyptian Hieroglyphics,” you will add a 
Text Object and a Graphic Object.  The Graphic Object will activate a ready-
made HyperStudio animation.  Think of Buttons, Text Objects, and Graphic 
Objects as things that float over the background, rather than becoming part of the 
background.  They can be moved and edited without affecting the background. 
 
 
 
 
 
 
 
 

Seeing Isn’t Always Believing… After 23 years of study, the 
Rosetta stone finally relinquished the key to understanding 
hieroglyphics in a single word—Ptolemy.  Ironically, even though 
Champollion is credited as having made the breakthrough 
discovery of the cartouche, he worked from only copies and 
models of the Rosetta stone.  He used symbols found on 
obelisks, artifacts, and papyrus to understand the meaning of the
symbols, but he never saw the actual Rosetta stone! 
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Add a Text Object 
 
Unlike painted text, a text object can be edited, and can be moved around; it is 
not a permanent part of the background. 
 
Add a Text Object. 
 

1. From the Objects menu, select Add a Text Object…. 
 
2. A box surrounded by dotted red lines will appear on your card.  Move the 

text box to the top right side of your card with the four-headed arrow 
cursor and use the double-headed arrow cursor to resize the box. 

 

 
 
3. Click once outside the box to set it in place and open the Text 

Appearance dialog box. 
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4. Check Draw scroll bar, Scrollable, and Draw frame.  With the scroll 
feature, you can add a lot of text.  Select Text and Background colors.  We 
chose dark blue and white but you can choose anything. 

 
5. Click Style to choose from a variety of fonts and sizes.  An example of 

your choices will appear in the window.  Choose at least 14 pt for the font 
size.  Click OK twice.   
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6. Notice the I-beam cursor in the top left corner of the Text Object.  If the I-
beam cursor is not present, change to the Browse tool and click inside the 
Text Object.  Enter the following text: 

 
Champollion, an Egyptologist, was dedicated
to unlocking the meaning of the hieroglyphs.
He eventually triumphed in his quest.

 
7. With the Edit/Selector tool, you may click on the Text Object at any time.  

You can resize the box with the double-headed arrow cursor, or move the 
box with the four-headed arrow cursor. 

 
8. You may edit text by selecting the Browse tool, and clicking it inside the 

text box.  It becomes the I-beam cursor, and you can begin typing. 
 

Your card should look like this: 
 

 
 
 

Add a Graphic Object 
 
Graphic Objects can have the actions of Buttons and the appearance of clip art, 
but are easy to move around the screen. See the HyperStudio Reference Manual 
for more detailed information about Graphic Objects.   
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To add a Graphic Object: 
 

1. Open the Media Window and select the Clip Art gallery. 
 

2. Drag the Champollion file onto the card while the Alt key is depressed. 
 
3. In the Drop Options dialog box, select Create a graphic object… and 

choose OK. 
 

4. Using the Square Selector tool, capture the image of Champollion and 
choose Scale & Rotate. 

 
Rotate an Image 
 

1. Enter a rotation angle of 10, check counter-clockwise, and choose OK. 
 
2. Double click the Lasso Selector tool to capture the rotated image of 

Champollion, and choose OK. 
 

3. Using the four-headed arrow cursor, move the Graphic Object of 
Champollion to the position shown and click outside the image on the card 
to set it in place. 

 

 
 

4. The Graphic Appearance dialog box appears.  Select Actions. 
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Add Ready-Made Animation 
 
Buttons can have actions, and so can Graphic Objects. 
 

1. The Actions dialog box appears.  From the Things to Do… list, select 
Play Animation.  The dialog box below appears. 

 

 
 

2. Notice that the Square Selector and the Lasso Selector tools appear next 
to the Current card.  These tools are used to animate images from the 
card.  For this animation, select Disk Library. 

 
3. From the Please select a picture file, move up a level (click on the folder 

with an arrow going up) to the Media Library folder Tutorial Art. 
 

4. Select the EgyptianScribe.gif file, and preview it, if desired.  Click OK, and 
the figure of an Egyptian scribe will appear on your screen.  Move it just to 
the right of the Rosetta stone so it appears that he’s carving the stone.  
This is a ready-made animation that will not change places on the card, so 
click the mouse once with the scribe in place and then press any key on 
the keyboard to end the path in exactly the same spot (the scribe will stay 
in place while chiseling). This technique is called Single Point Path 
Animation.  The Animation dialog box automatically opens.  (All the 
features of this dialog box are covered in Chapter 10 of the HyperStudio 
Reference Manual.) 
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5. Make the white frame around the scribe transparent by checking 
Transparent color and clicking on the window next to it.  The cursor turns 
into the Eyedropper tool. 

 
6. Click the Eyedropper on the white background in the Frame Preview box.  

Notice that the Transparent color box turns white.  Now the frame 
surrounding the scribe will be transparent and let the background color of 
the card show through. 

7. Under Frame Options: check Erase when done.  Under Play for, select 
seconds, and enter 10 in the window.  (See the Animations dialog box 
illustration.) Choose Try It to preview the animation and then choose OK. 

 
Add Sound to a Graphic Object 
 

1. The Actions dialog box returns when the Animations dialog box is 
closed.  Now select Play a sound… to open the Digital Audio Deck 
dialog box. 

 
2. Select a sound for the chiseling scribe from the Samples window and 

choose OK. 
 

3. Finally, choose Done to close the Actions dialog box and OK to close the 
Graphic Appearance dialog box. 

 
You’ve now added an animation and sound to Card 2.  The animation will not 
appear until you activate it by clicking Champollion (a Graphic Object).  Test your 
animation and sound by selecting the Browse tool from the Tools palette and 
clicking on Champollion.  The scribe will appear and chip away at the stone. 
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Your card is now complete with its presentation of the discovery of the Rosetta 
stone, and the resulting unveiling of the mysteries and intrigue of ancient Egypt’s 
language. 
 
Click File and select Save Stack to save the stack in the HyperStudio directory.   
 
Save Stack As… 
 
To save the first two cards of your Timeline stack to a different location or give it 
a different name, click File and select Save Stack as…. 
 
The Save As dialog box appears.  Change the directory to the new location or 
type in a new name. 
 
Choose Save. 
 

 
 

To recap, in Card 2 you 
• Created a card border using a background from the Media Library 
• Used the Paint Bucket Fill tool 
• Added a title 
• Added two scaled clip art images 
• Imported a portion of an image 
• Used the Rounded Rectangle tool 
• Copy and resized an image 
• Created navigation Buttons using background images 
• Added icons to Buttons 
• Created a Text Object 
• Rotated an image 
• Added ready-made animation 
• Added sound to a Graphic Object 

 
Take a well-deserved break, or zoom ahead into the Middle Ages with Card 3. 
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Section 3  Traversing with Text 

 
Section 3 will take approximately one hour to complete. Explore these essential 
skills in this tutorial: 
 
▶ Use the StoryBoard Feature 
▶ Add a Background using the File Menu 
▶ Use the Eyedropper Tool 
▶ Add Painted Text 
▶ Become an Experienced HyperStudio User 
▶ Add a Text Object using a Text File 
▶ Add More Colors 
▶ Edit Text Objects 
▶ Import Clip Art 
▶ Use the Opacity Feature 
▶ Add a Transparent Text Object 
▶ Use the Spell Checker 
▶ Convert Clip Art into a Graphic Object 
▶ Use a Graphic Object to Play a Path Animation 
▶ Add a Sound Effect 
▶ Add an Interactive Cursor 
▶ Add and Copy Navigation Buttons 
▶ Bonus – Planning Stacks 
 
The third card, “Medieval Ages: Illumination,” will look like this when you have 
completed this section: 
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With Cards 1 and 2, you used HyperStudio’s special features to explore early 
writing forms.  You have included information ranging from cave drawings to 
hieroglyphs for a multimedia presentation.  Read on to find out about another 
stage in the evolution of written communication and how you can use 
HyperStudio to display writing as it evolved during the Middle Ages.  You will get 
a close view of how monk scribes and artists of the Middle Ages illuminated and 
copied manuscripts. 

 
 
 
 
 

 
 
 
 

 
If you are returning to the tutorial, open your stack from the Home Stack or click 
Open Stack from the File menu.  Remember, your stack name is HistoryofWriting 
and is saved in the MyStacks folder.   

Most Beautiful Book in the World… Illuminated manuscripts were 
the only form of books made in Europe until the 15th century.  The 
Book of Kells is widely renowned as one of the most beautiful books 
in the world.  It was written around 800 A.D. on vellum, and contains 
the four gospels in Latin text.  Every page in this illuminated 
manuscript is decorated with impeccable and intricate designs.  
Historians believe that at least four different artist monks created the 
illuminations for this outstanding treasure.   
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Use The StoryBoard Feature 
 
At the end of Card 2 you added Card 3.  View your stack and go to this card 
using the StoryBoard feature.  Choose the Extras menu and click on StoryBoard.  
You should see the three cards from your stack, depicted in miniature or 
“thumbnail.”  Notice the options here.  You can delete or move cards as desired.  
Select the third card by clicking on it.  A red line will surround it.  Choose Go to 
Card.  Timeline - Card 3 should show at the top of your screen, and you are 
ready to begin.   

 

 
 

Shortcut:  You can also move through the stack using Ctrl/Command < or  >. 
 
 
 
 
 
 
 
 
 
 
 
What is so intriguing about The Book of Kells is the intricate interlacing effect.  
The complex artwork follows patterns of repetition, alternation, and reversal.  You 
will see samples of the artistic scribes’ work in some of the images you will import 
for this section.  You, too, will be able to add intriguing effects.  Read on to find 
out more as you learn to illuminate your own HyperStudio artwork. 

Designs for the Manuscripts… The work in Irish monasteries 
was initially focused on copying religious books.  It is 
speculated that copyists may have been bored with their work, 
so doodled and drew in the margins, using patterns common to
the crafts and designs of their culture.  These doodles 
eventually became stylized and celebrated as an art form, 
merging early Christian designs with Germanic and Celtic 
metalwork traditions. 
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Add a Background using the File Menu 
 
Here’s another way to add elements to your stack. Use the File menu command, 
Import Background… to add a border to your card.   
 

1. From the File menu, select Import Background…. 
 

 
 

2. A dialog box opens asking where to get the graphic.  Select Disk file and 
click OK.  The Please select a picture file dialog box appears. 

 
3. Open Backgrounds folder in the Media Library. 

 
4. Check the Show Preview box, select MedievalBorder.jpg, and open the 

file by double-clicking it. 
 

 
 

5. If a dialog box asking about resizing the picture to fit the card appears, 
choose Yes. 
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6. The border has been added to the card. 
 

 
 

Let’s add a title to the Card 3. 
 
Use the Eyedropper Tool 
 
This time, when you use the Paint Text tool (T) to add a title, try matching the 
color of the border.   
 

1. Use the Eyedropper tool to pick a color from the blue background, which 
now becomes the selected color for all tools except the Paint Text tool (T).  
Selecting the color with the Eyedropper tool adds that color to the Colors 
palette, making it available for use with the Paint Text (T) tool. 
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Add Painted Text 
 

2. Select the Paint Text tool (T), click Colors and select the background color 
from the palette.   

 
3. Click Format and select Text Style… to open the Text Style dialog box. 

 
4. Select a text font, style, and size 

 
5. Add the title, “Middle Ages: Illumination.”  Use the Lasso Selector tool to 

move the title to the upper right corner of the card. 
 

 
 
Become an Experienced HyperStudio User 
 
It’s now time to become acquainted with the advanced HyperStudio features you 
will use to make Card 3.  HyperStudio simplifies some of its procedures while you 
are learning, but now you are familiar with many of the basic procedures and it’s 
time to step it up a notch! 
 

1. From the Edit menu, select Preferences to open the Preferences dialog 
box.   

 
2. Check the box I’m an experienced HyperStudio user, and click OK. 
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Add a Text Object using a Text File 
 
To import a text file into a Text Object: 

1.  From the Objects menu, select Add a Text Object or use Ctrl T or 
Command T to create a text object.   

 
2. The rectangle of dotted red lines indicates where the text object will be.  

Move it to the upper right of your card, and resize it to fill the corner of the 
card. Overlap the border a little, if you like. Click outside the box to set the 
Text Object and open the Text Appearance dialog box.   

 
3. Click Get File.  The Please select a text file dialog box appears. 

 

 
 
4. Open the Cartoons and Whimsy.txt file in the Text folder in the Media 

Library.  It will appear in the preview window on the Text Appearance 
dialog box. 

Setting New Standards…  During the Middle Ages, the work of 
writing manuscripts was all-consuming.  Manuscripts and sacred 
texts were considered status symbols.  In the Middle Ages, the 
principle function of monasteries was copying text in order to 
spread Christianity.  The traditional method of relying on word of 
mouth for information was changing.  Manuscripts allowed people 
to receive more standardized information. 
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Add More Colors 

 
5.  Select a text color and background color for the text box.  See the preview 

window to ensure that the text color shows up clearly against the 
background.  

 
Because you checked I’m an experienced HyperStudio user, you now have more 
colors available.  Double-click on any color on the Colors palette in the Text 
Appearance dialog box (or any Colors palette set on the screen).  The More 
Colors! dialog box opens, providing you with many more choices.  Choose a 
color, then choose OK. 
 

 
 
To find even more choices, double-click on the color closest to the one you want, 
and the Color Chooser dialog box opens.  Use the dial-up windows, slider bar, 
or crosshairs cursor to change the color.  The original color and new color are 
shown for comparison in the window on the upper left.  When you are satisfied 
with your choice, click OK, until you return to the Text Appearance dialog box. 
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6.  Click the Style… button and select the same font as used for the title.  
Click OK.  In the Text Appearance dialog box, you can uncheck the Draw 
frame option, but it’s important to leave the Scroll bar and Scrollable 
options checked so viewers can read the entire text.   

 
7.  Click OK when you are pleased with the Text Object's appearance.   

 
8. Change your tool to the Browse tool (Shift Tab) to scroll through the text. 
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Edit Text Objects 
 
It’s easy to make changes to the Text Object’s attributes. Use the Edit/Selector 
tool and move it over the Text Object.  It turns into the four-headed arrow cursor.  
Double-click it to open the Text Appearance dialog box.  You are now free to 
make changes.   
 
To edit text within a Text Object, select the Browse tool from the Tools menu.  
Click the cursor inside the Text Object, making it the I-beam cursor.  You can 
now use it to edit the text. 
 
Import Clip Art  
 
Drag-and-drop the image of The Book of Kells from the Media Library 
(BookKells.bmp file) while depressing the Alt/Option key and select Lasso the 
clip art.  Remember, all you need to do is switch to the Edit/Selector tool, open 
the Media Window by clicking Options, and selecting Show Media Library, or 
use the shortcut, Ctrl D or Command D.  Place the image in the upper left corner 
of your card beneath the title.  Click outside the image to set the book in place. 
 

 
 
HyperStudio has many special effects designed to transform ordinary clip art into 
an extraordinary design effect.  Next. you will alter a piece of clip art to make a 
backdrop for a transparent Text Object.  It’s a lot easier than it sounds! 
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Use the Opacity Feature 
 
It is easy to create a Graphic Object that has the appearance of a dim screen on 
which to show other images or text. You will import the image of a book and 
adjust its opacity so that it may be used behind a transparent Text Object.  The 
dimmed image will show through the Text Object but the text will be clearly 
visible. 
 
To create an opacity-adjusted Graphic Object 
 

1. Using the Media Window, find the Book.bmp file in the Clip Art folder and 
drag in onto the card while depressing the Alt key. Choose Create a 
graphic object…. 

 
2. Scale the image to 200%. Then double click the Lasso selector tool and 

choose OK. 
 

3. Place the Graphic Object of the book beneath the Book of Kells and click 
outside it to open the Graphic Appearance dialog box. 

 

 
 

4. Adjust the Opacity slider to 30% and choose OK. 
 
Save your stack (Ctrl/Command S). Card 3 should look like this:  
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Add a Transparent Text Object 
 
Next you will make a transparent Text Object so that the book will appear in the 
background behind the text.   
 

1. Click Objects and select Add a Text Object… or press Ctrl T or Command 
T.  Move the dotted red lines so the text box is over the Graphic Object 
and resize it to fill the corner of the card.   

 
2. Click away from the Text Object to open the Text Appearance dialog box. 

Select Draw scroll bar and Scrollable. Deselect Read only and Draw 
frame. 

 
3. Choose the Features option (available only to experienced HyperStudio 

users) to open the Object Features dialog box. 
 
4. Check Transparent and choose OK. 

 
5. Now, choose a font, style, size, and color. The background will be 

transparent, so there is no need to choose a background color.  Choose 
OK, then OK again. 

 
6. Open the Media Window and select the Text folder.   

 
7. Using the Edit/Selector tool, drag the Kells.txt file from the window to the 

Text Object. 
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Use the Spell Checker 
 
To avoid spelling errors, use the Spell Checker from the Extras menu.  The 
Check Spelling dialog box will open.  Check This Card and choose Start.  Spell 
Checker will scan the text in each Text Object, stop whenever it suspects a 
misspelled word, and offer suggestions.  You will have the option to skip the word 
or replace it.  If the dictionary doesn’t recognize a word that is correctly spelled, it 
will present it as a misspelled world; you can choose Add to add this word to the 
dictionary so it will recognize the word as being correctly spelled.  The dialog box 
will close automatically when it has finished scanning all the Text Objects on the 
card. 

 

A Medieval Treasure… Some pages in The Book of Kells 
are filled by a single letter elaborately decorated with 
remarkably intricate patterns, colors, and designs.  Some 
pages were so beautifully made that the letters were thought 
to have magical powers. Today, The Book of Kells is on 
display in the Old Library of Trinity College in Dublin, Ireland. 
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Now is a good time to save your work. 
 

Next, you will add a picture of an artist monk to the lower right corner of your 
card, turn it into a Graphic Object, and add an animation that will be activated 
when you click on the image of the monk. 
 

 
 
HyperStudio presentations include special effects, like the ready-made 
animations added to Card 2.  Your next animation will be of a flying book that has 
a path that begins by the scribe and ends at The Book of Kells. 
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Convert Clip Art into a Graphic Object  
  

1. Using the Media Window, select the Clip Art directory and find the file 
called MedievalScribe.bmp.  Using the Edit/Selector tool, drag-and-drop 
the image onto the card while depressing the Alt/Option key. 

2. Select Crop the clip art… and choose OK. 
 

3. Scale the image to 70% and select it by double-clicking the Lasso selector 
tool. Choose OK. 

 
4. Using the four-headed arrow cursor, move the image to the lower right 

hand corner of the card. 
 
5. Click outside the image to set it in place.   
 
6. Recapture the image using the Lasso Selector tool.  Then choose Add a 

Graphic Object… from the Objects menu. 
 

 
 
7. A dialog box opens asking if you want the selection to be a Graphic 

Object.  Choose Yes. 
 
8. From the Graphic Appearance dialog box select Actions, and then select 

Play Animation from Things to Do. 
 
Use a Graphic Object to Play a Path Animation 
 

1. Select Disk Library from the dialog box that opens.  From the Please 
select a picture file dialog box, look in the Media Library folder, open the 
Animations folder, and select the BookFly.gif.  GIF files include several 
frames that create animation. 

 
2. The book image will appear on your screen (do not click the mouse button 

yet).  Move the book so it sits on the book on the monk’s stand.  Now click 
the mouse button and drag the image to The Book of Kells.  Press any key 
on the keyboard to end the animation path.  You have now created a path 
for the animated book to “fly” along.  The Animation dialog box opens. 
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3. Click Try it to look at your animation.  Keep it if you like, or experiment with 

the options.  You can edit the path, change the speed of the pages 
flapping, have the image stay on the card after the animation, or match the 
animation speed to the path speed.  Play with the animation until you are 
satisfied. The settings we chose are shown below.  Click OK to return to 
the Actions dialog box. For more information on animation, see Chapter 
10 of the HyperStudio Reference Manual. 

 
 

 
 
 
Add a Sound Effect 
 
To add a sound effect to the animation: 

1. Click Play a sound… to open the Digital Audio Deck dialog box.  Choose 
Disk Library and select Medieval.wav from the Sounds file in the Media 
Library.  Choose Open, then OK. 

 
2. Click Done in the Actions dialog box. 
 

Add an Interactive Cursor 
 
Finally, let’s add a cursor that only appears when the Browse tool is passed over 
the monk.  We’ll choose the Grabhand cursor so we can grab the book to make it 
fly! 
 

1. In the Graphic Appearance dialog box, choose Features… and select 
Cursor… to open the Cursors dialog box. 
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2. Select the Grabhand cursor and choose OK. 
 
3. Then choose OK in the Object Features and Graphic Appearance dialog 

boxes to return to the card. 
 
Choose the Browse tool and pass it over the monk.  Notice that it turns into the 
Grabhand cursor. 
 
Click the mouse to watch the animation and listen to the sound.  Save your stack.  
Select File and choose Save Stack (Ctrl/Command S). 
 
 
 
 
 
 
 
 
 
 
 
Now it’s time to create navigation Buttons that allow the users to move easily to 
the previous or next card.  First, create Card 4 by pressing Ctrl N or Command N.  
Click Move and select Back to return to Card 3.   
 
Add and Copy Navigation Buttons  
 
You are going to create the Back Button with an associated sound and transition.  
Then you will copy this Button, place it on the opposite side of the card, and edit 
it to say Next. 
 

1. Use the shortcut, Ctrl B or Command B, to open the Button Appearance 
dialog box.  Select the shadowed rectangle (number 4).   

Gold and Bugs… The colors monks preferred included 
brilliant reds, greens, blues and gold—real gold!  Illuminators 
mixed the gold with mercury to make it easier to use, and 
applied it before adding colored inks.  Monks made their own 
inks by grinding pigments.  For instance, to create the rich 
reds, scribes mixed red lead and kermes—a pigment extracted 
from female Mediterranean insects called cochineal! 
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2. Select the Text Style by clicking Format.  Choose a font style that is 

consistent with that of the rest of your card.   
 

3. Then select a dark background color and a light name color.   
 

4. Now type “Back” in the Name field and choose OK. 
 

5. Your Button will appear on the card, outlined with dotted red lines.  Move 
the Button to the bottom left corner of the card and click outside it to open 
the Actions dialog box. 

 
6. In the Places to go… section, choose Previous card. 

 
7. Select Cross Fade and Slow in the Transitions dialog box (or any 

combination), and click OK to return to the Actions dialog box. 
 

8. In the Things to do… section, choose Play a sound…. 
 

9. Using the Digital Audio Deck dialog box, select Chimes.wav from the 
Sounds folder in the Media Library, and choose Open, OK, then click 
Done in the Actions dialog box, and return to the card by clicking OK. 

 
Your card will look like this: 
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Now we are going to create the Next Button by copying the Back Button and 
making minor changes. 
 

1. Select the Back Button using the four-headed arrow cursor by clicking 
once on it to highlight it. 

 
2. Click Edit and select Copy Button (or Ctrl C or Command C). 
 
3. Next, click Edit and select Paste Button (or Ctrl V or Command V).  The 

copy of the Back Button is sitting right on top of the original.  Drag it off, 
using the four-headed arrow cursor. 

 
4. Move the Button copy to the bottom right corner of the card and double-

click it to open the Button Appearance dialog box. 
 
5. Change Back to Next in the Names field. Choose Actions…. 
 
6. Change Previous card to Next card and click Done.  Then click OK to 

return to the card. 
 

You now have two Buttons with identical sounds and transitions, allowing you to 
move easily from one card to another.  You can copy Buttons (or Text or Graphic 
Objects) and paste them elsewhere with their associated features and actions 
intact, even to other cards in the stack or other stacks. 
 
Be sure to save your four-card stack.  You may now exit HyperStudio by clicking 
File and selecting Exit, or continue the tutorial by going to Card 4. 
 
Bonus – Planning Stacks 
 
Many HyperStudio users find it particularly helpful to develop the habit of making 
storyboards before beginning to construct cards and stacks (see the Planning 
and Assessment chapter in the HyperStudio Teacher’s Guide.)  A storyboard is a 
sketch of the step-by-step process for building your card or stack.  For example, 
a storyboard of Card 3 might look like this: 
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To recap, on Card 3 you: 
 
• Used the StoryBoard feature 
• Added a background using the File menu 
• Used the Eyedropper tool 
• Became an experienced HyperStudio user 
• Added a Text Object using a Text file 
• Learned how to use more colors 
• Learned how to edit Text Objects 
• Used the Opacity feature 
• Added a transparent Text Object 
• Used the Spell Checker 
• Converted clip art into a Graphic Object 
• Used a Graphic Object to play a path animation 
• Added a sound effect to the animation 
• Added an interactive cursor 
• Added and copied navigation Buttons 
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Section 4  Grasping Graphics 
 
 
Section 4 will take approximately one hour to complete. Explore these essential 
skills: 
 
▶ Add a Background 
▶ Use the Oval Tool 
▶ Add a Frame to a Graphic Object 
▶ Add a Sample Sound 
▶ Add a Path Animation 
▶ Set a Background Sound 
▶ Add a Graphic Object 
▶ Create a Hidden Graphic Object 
▶ Create a Hypertext Link 
▶ Import Text File 
▶ Add a New Button Action 
▶ Use the Cookie-cutter Effect 
▶ Delete Cards 
▶ Add a Graphic Object 
▶ Add a Movie 
▶ Add a Sound 
▶ Copy and Paste Buttons 
 
 
Your fourth card, “Renaissance: First Printing Press,” may look something like 
this when you complete this section: 
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Add a Background 
 
Use the Media Window or the File command method to import the FirstPress.jpg 
file from the Background folder in the Media Library.   

 

A New Era Unfolds… The Chinese were the first to invent block 
printing.  The Diamond Sutra, a Buddhist prayer book, is the 
earliest dated block-printed book made in China, and dates to A.D. 
868.  Because carving an entire text on a wood printing plate was 
arduous, the Chinese carved individual characters that could be 
used again and again.   
 
In Europe, the “photocopy machines” of the Renaissance, like 
those of the Middle Ages, were still scribes who painstakingly 
copied manuscripts and documents.  It became popular for people 
to copy or have copied favorite passages; these pages would be 
bundled with ribbons and cords.  Scriptoria and writing shops were 
overwhelmed by orders.  The copying process was tedious and 
time consuming.  It was not uncommon for book orders to take 
years to fill. 
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Now you are going to create artwork and convert it into a Graphic Object.  Then 
you will add the actions: a sound and a path animation of a portion of the 
background clip art.  Let’s begin! 
 
 
Use the Oval Tool 
 

1. From the Tools palette, select the Oval Tool. 

 

The Demand Grows… In an earlier age, wealth was determined 
by the amount of land owned by a family.  Art and books 
eventually joined the official ranks of what constituted wealth, and 
people clamored to fill their homes with these valuable objects of 
culture.  Because of such high demands for both Biblical 
passages and secular material, scribes were unable to keep up 
with the workload.  However, people in other countries, most 
notably in The Netherlands, Italy and France, were working 
toward a faster way of copying text.  Experts in the history of 
printing have debated the question of exactly who invented the 
first movable type printing press. 
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2. From the Options menu, select Draw Filled (or double-click the tool on the 
torn off palette to toggle between filled and unfilled). 

 
3. From the Colors palette, select the blue gravel pattern. 

 

 
 

4. Place the crosshairs cursor in the middle of the card and draw a small 
filled oval.  This represents an ink puddle. 

 
5. Select the Paint Text tool (T) then click Format and select Text Style…. 
 
6. Choose any font, size, color and style for your text that will fit inside the 

oval and type “INK” anywhere on the background of the card.  For the 
sample, we chose Engravers MT, 10 pt, Bold, in black. 

 
7. From the Tools palette, select the Lasso Selector tool and encircle the 

word INK.  Now move it to the center of the oval you created and set it in 
place. 

 
8. Using the Lasso Selector tool again, encircle the image you’ve created, 

and from the Objects menu, choose Add a Graphic Object… to turn your 
art into a Graphic Object so you can add actions to it. 
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The Graphic Appearance dialog box opens. 
 
 
Add a Frame to a Graphic Object 

 
1. Select a color from the Frame Colors palette (we chose tan).   

 
2. Using the dial up arrow, set a frame width of 2.  Notice that the frame does 

not apply itself to the outside of the image’s edges, but to it’s inside, 
thereby reducing the image by the frame width.  
 

3. Choose OK and move the image to the lower left corner of the card, using 
the four-headed arrow cursor.   

 

 

 



 131

 
 
 

 
 
 
 
 
 

 
 

 
 
 
Add a Sample Sound  
 

1. Place the cursor over the image and double-click to reopen the Graphic 
Appearance dialog box.  Click the Actions button to open the Actions 
dialog box.  Select Play a sound… in the Things to Do column. 
 

2. From the Digital Audio Deck dialog box, select Magicwand1.wav from the 
Disc Library, and choose OK to return to the Actions dialog box. 
 

Before you try out the sound, let’s add some animation. 
 
 
 

Working in Secret… Laurens Coster of Haarlem, The 
Netherlands, was the first European to use movable type in 1423, 
and he used it to -print pamphlets and fliers.  Pampilo Castaldi, an 
Italian, was also instrumental in designing a movable type press.  
Records also show that Procopius Waldfoghel, a Czechoslovakian 
who was living in France, was developing a secret method of 
“writing artificially.”  People worked in secret because no patent 
laws existed to keep others from stealing ideas.  Some people 
thought that printing books was somehow wrong or immoral—that 
mass-producing text somehow diminished its spiritual significance. 
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Add a Path Animation 

 
1. Select Play animation… from the Things to Do column in the Actions 

dialog box. 
 

2. A dialog box will open, asking where you would like to get your image.  
Choose the Square Selector tool and click Current Card.  A crosshairs 
cursor will appear on your card.   
 
 

 
 

3. Use the cursor to capture the letter “h” in the upper left corner of the card’s 
background. 
 

4. Release the mouse button and the image will now float freely on the card.  
Without depressing the mouse button, move the image to the bottom of 
the card and center it in the ink puddle. 
 

5. Now press the mouse button and slowly drag the image up to the top left 
corner and superimpose it on the “h” that remained on the background.  
Next, depress any key on the keyboard to end the animation path.  The 
Animation dialog box will open. 

 

Johannes Gutenberg, First to Print a Book…  Even 
though many people were working on ideas about how to 
print copies of books faster, historians seem to agree that 
Johannes Gutenberg, a German from Mainz, was the first 
to print a book using movable type. 
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6. Check Erase when done, and then check Allow clones.   
 

7. From the Path drop-down menu, select Path Options… to open the Path 
Options dialog box. 

 
 

We will be adding other Graphic Objects to this card, and we want the “h” to 
float over the top of them on the card.  The Path Options dialog box lets you 
make many changes in the animation path.  You can reverse the direction, 
loop the path, or have the image float over or under Objects.  Don’t be afraid 
to experiment, and remember to use the Try It button in the Animation dialog 
box to check the results before returning to your card!   
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8. Check Float over, select Top from the Layer drop-down menu, and choose 
OK.   
 

9. Choose Try It and then close all dialog boxes by choosing OK and Done 
to return to Card 4. 
 

10. Select the Browse tool and test your animation by clicking on the Ink 
puddle several times in a row.  Notice that each time you click it, the letter 
flies up from the puddle, even if another letter is still flying.  This is the 
effect of the Allow clones option in the Animation dialog box.  Notice that 
the sound gets interrupted when each new sound is activated.  

 
Next, you’re going to change a setting so that the sound will play continuously 
each time the Graphic Object. 
 
Set a Background Sound 
 
Background sounds are sounds that will continue to play when another sound is 
activated. 
 

1. Using the Edit/Selector tool, return to the Digital Audio Deck dialog box 
by double-clicking the Graphic Object with the four-headed arrow cursor.  
Click Actions… in the Graphic Appearance dialog box, and double-click 
Play a sound… in the Actions dialog box.  Double-clicking the already 
checked box reopens the Digital Audio Deck dialog box. 

 
2. Check the Background Sound option in the Digital Audio Deck dialog 

box.  Close the dialog boxes by choosing OK, and click Done to return to 
Card 4. 

 
Your card will look like this when you click your Graphic Object (the ink puddle) 
and the sound should play without interruption when you clone the animation by 
clicking it again.  (Remember to switch to the Browse tool first.) 
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Add a Graphic Object 
 
You are now going to create a Graphic Object from Egyptian art, hide it, and 
make it show up when you click on words in a Text Object.  Let’s get started. 
 

1. Open the Media Window, go to the Backgrounds folder, and drag the 
EgyptianArt.jpg file onto the card while depressing the Alt/Option key. 

 
2. In the Drop Options dialog box, select Create a graphic object…. 

 
3. Using the Square Selector tool, select several hieroglyphs and choose 

OK. 
 
 

Modifying a Grape Press to a Printing Press… In the 1440s, 
Gutenberg modified a grape press and assembled pieces of 
carved type into a form placed on the bed of the press.  He 
designed and installed a rollout paper tray that allowed him to 
slide paper easily in and out of the press.  Then, by tightening 
a huge wooden screw against a wood block, the paper 
underneath was imprinted by the inked letters below. 
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Create a Hidden Graphic Object 
 

1. Click outside the hieroglyphic Graphic Object. The Graphic Appearance 
dialog box opens. 

 
2. Give the Graphic Object a name by typing “Hieroglyphs” in the Name 

window. 
 

 
 

3. Select Features… to open the Features dialog box.  Check Hidden and 
choose OK.   

 
 

4. Choose OK in the Graphic Appearance dialog box to return to Card 4. 
 

5. Using the four-headed arrow cursor, position the Rosetta stone Graphic 
Object in the upper left of the card. 
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You have created a Graphic Object that will be hidden when the Browse tool is 
selected.  Try it!  Now you must create a way to make the Graphic Object 
appear.  You will make the Rosetta stone appear by making a Text Object that 
contains a Hypertext phrase.  Hypertext is a word or phrase that, when clicked 
with the Browse tool, causes an action to occur (much like a Button).  In this 
case, the action will be to make the Hieroglyphics appear. 
 
Create a Hypertext Link 
 
First you will create a Text Object and add a short paragraph that will include the 
phrase you will use as Hypertext. 
 

1. Switch to the Edit/Selector tool.  From the Objects menu, select Create a 
Text Object….  Resize the text box, move it to the upper right corner of the 
card, and click outside it to open the Text Appearance dialog box. 

 

 
 

2. Make the following selections: 
Uncheck Draw scroll bar and Scrollable 
Uncheck Read only 
Check Draw frame 
Any font style 
Any font size 
Center align 

 
3. Choose OK  
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Import Text File 
 
To add text to the Text Object 
 

1. Be sure the I-beam cursor appears in the Text Object. 
 

2. Click File, select Import Text and choose the Gutenberg.rtf file from the 
Text folder in the Media Library. 

 
The top of your card should look like this: 
 

 
 

A hypertext word or phrase is often changed so it will stand out to the reader.  
You’re going to change regular type in the hypertext phrase by changing the 
color and making it bold. 
 

3. Select the Browse tool and click inside the Text Object to turn it into an I-
beam cursor.  Using the I-beam cursor, highlight the phrase “ancient 
times.” 

 
4. From the Format menu, select Text styles….  Pick a new text color and 

check Bold and Underline.  Choose OK to close the dialog box.  Click the 
Edit tool in the Tools palette to see the changes in the Text Object. 
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5. Using the I-beam cursor, highlight the phrase “ancient times” again. 
 

6. From the Objects menu, select Hypertext Links… to open the Hypertext 
dialog box. 

 

 
 

7. Check This Field Only (to limit the hypertext to only this appearance of 
“ancient times” in the stack), select Add Link and then select Actions…. 

 
Add a New Button Action 
 

8. Select New Button Actions… from the Actions dialog box to open the 
New Button Actions dialog box. 

 

 
 

9. From the Names window, select HideShow2NBA.  Notice that the 
scrollable Info window describes how the New Button Action works. 

 
10. Click Use this NBA to open a dialog box for making selections. 
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11. Type “Hieroglyphs” in the name window (the name you gave to the 
Graphic Object you just created). 

 
12. Check Graphic, and then Toggle. 

 
13. Click Hide Effect… to open the Transitions dialog box. 

 
14. Select any transition (we chose Dissolve); then select Fast.  Choose OK. 

 
15. Click Show Effect… and make the same choices. 

 
16. Choose OK to return to the New Button Action dialog box, and choose 

OK. 
 

17. Choose Done in the Actions dialog box and choose Done again to return 
to the card. 

 
You have now finished creating a Graphic Object that will appear when you click 
on the hypertext, “ancient times.”  Select the Browse tool and click on the phrase.  
The Graphic Object will appear.  Click the phrase again, and it will disappear.  
Notice the transition effect as it appears and disappears.  HyperStudio lets you 
create lots of surprises like this one using New Button Actions.  We will explore a 
few more in this tutorial, but don’t hesitate to try others as you create stacks. 
 
It’s good idea to save your stack now.  Click File and select Save Stack or press 
Ctrl/Command S. 
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You’ve created a path animation activated by a Graphic Object and a hypertext 
link that shows a hidden Graphic Object. Now you are going to learn about a 
technique that can be used with clip art or painted text to create an interesting 
visual effect.  The effect is called Cookie-cutter, which cuts shapes out of any 
background, using a “cutter” that you create.   
 
Often, when you create special effects for a card, it’s a good idea first to add a 
“scratch” card or two to work on, then delete the scratch cards after you have 
created and transferred your effect.  To do so, press Ctrl N or Command N.  You 
will next create the title, “Renaissance: First Printing Press” by cutting the letters 
out of a background that looks like wood bark. 
 
Use the Cookie-cutter Effect 
 

1. Create two scratch cards with white backgrounds. 
 

2. On the first scratch card, add the title: Renaissance: First Printing Press. 
Use the Painted Text tool and any bold, plump font. 

 
3. Move to the second scratch card and click Edit and select Erase 

background…. 
 

4. Select a medium brown color and choose OK. 
 

5. Click Edit, select Effects, and choose Texturize…. The Texturizer dialog 
box opens. 

 
6. Select Treebark from the pull down menu in the top right corner.  Then 

adjust the Relief and Scale sliders and experiment with selecting Invert or 
changing the orientation of the texture by using the pull down menu in the 
bottom right. When you are satisfied with the results, choose OK. Your 
entire scratch card will look like the preview window. 
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7. Return to the first scratch card and capture the title using the Lasso 

selector tool. 
 

 
 

8. While the title is still captured, click Edit and select Copy.  Move to the 
second scratch card, click Edit and choose Paste (or use the shortcuts, 
Ctrl/Command C and Ctrl/Command V).   

 
9. Again, while the title is still captured, click Edit and select Effects and 

choose Cookie-cutter. 
 

 
 

10. Click Edit and select Cut (or press Ctrl/Command X). 
 

11. Move to Card 4 and click Edit and select Paste (Ctrl/Command V). 
 

12. Position the title as shown below. 
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13. Save your stack. 
 
Delete Cards 
 
It’s now time to delete the scratch cards from your stack.  Got to the first scratch 
card, click Edit and select Delete Card.  A dialog box will open asking for 
confirmation.  Choose Yes. Repeat this procedure for the second scratch card. 
 
 

 
 

Another way to delete cards is to view the cards in StoryBoard format, an option 
in the Extras menu.  Select the card you wish to delete, and press the Delete 
key. 
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Add a Graphic Object 
 
Let’s add a picture of Gutenberg to Card 4 as a Graphic Object. Click File 
and select Add a Graphic Object… or use the Media Window to select the 
Gutenberg.BMP file. In the Graphic Objects dialog box, scale the image to 75%, 
use the Lasso tool to capture it, and choose OK. Your card should look like this. 
 

 
 

Cast Metal Movable Type and the Printing Press…  Hand carving 
an entire printing plate took almost as long as hand printing the 
copies, and wood blocks deteriorated during the use. To address 
these concerns, Johannes Gutenberg began experimenting with 
techniques of metalworking, such as casting, punch-cutting, and 
stamping.  Eventually he made letter molds and filled them with a 
molten alloy of lead, tin, and antimony. Using the cast letters, 
typesetters could more easily align the standardized forms in a frame. 
After letters (type) were set into frames, they were inked.  Printers laid 
sheets of paper on top of the inked letters, placed a heavy leather 
holder between the press and paper. Then pressmen pushed on the 
screw-like device that squeezed the printing beds together.  Casting 
and sizing letters, inking them, and pressing them with a modified ink 
press is the criteria historians use to acknowledge that Gutenberg 
was the first to successfully use a movable type printing press. 
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Gutenberg spent a great deal of time working by his forge.  Let’s add a movie 
and sound to show what it was like.  You’ll use the Graphic Object of Gutenberg 
to activate these effects. Using the Edit tool, double click on the Graphic Object 
to open the Graphic Appearance dialog box.  Choose Actions…. 
 
Add a Movie 
 

1. From the Actions dialog box, select Play a movie or video… to open the 
Video/Movie Source dialog box. 

 

 
 

2. Select Disk file and choose OK. 
 

3. From the Movies folder in the Media Library, double-click on the 
Campfire.MOV file.  The movie appears on the card, surrounded by dotted 
red lines.   

 
4. Using the four-headed arrow cursor, place the movie to the left of 

Gutenberg.  Click outside the movie to open the Movies dialog box. 
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5. Check Show first frame. To remove the image from the card after the 
movie has completed playing, check Erase when done. 

 
6. Choose OK, then Done to return to the card.  Select the Browse tool and 

click on Gutenberg to test the movie.   
 

7. Using the Paint Text tool and any font and color of your choice, add the 
instructions: Click Herr Gutenberg to see his forge. (A smaller, finer font 
size works best for giving instructions on a card.) 

 
When you click on Gutenberg, your card will look something like this: 
 

 
 

Add a Sound 
 
Using the Edit tool, double click Gutenberg to open the Graphic Appearance 
dialog box.  Choose Actions… to open the Actions dialog box.  Select Play a 
sound… and choose the Sizzle.wav file from the Disk Library in the Digital 
Audio Deck dialog box.  Choose OK and Done to return to the card. 
 
Save your stack. 
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Card 4 is almost complete. Let’s add Card 5 (Ctrl/Command N) and then add 
navigation Buttons. We’ll copy the Buttons from Card 3.  
 
Copy and Paste Buttons 
 
To copy a Button from Card 3 and place it on Card 4 
 

1. Move to Card 3 by pressing Ctrl/Command <. 
 

2. Using the Edit tool, click on the Back Button to highlight it. 
 

3. Press Ctrl/Command C (or click Edit and select Copy button). 
 

4. Move to Card 4 by pressing Ctrl/Command >. 
 

5. Paste the Button by pressing Ctrl/Command V (or click Edit and select 
Paste button). 

 
The Back Button will appear on Card 4 in the same location it was in on Card 3.  
It will have all the actions, including sound that it has on Card 3. 
 
Repeat these steps to move the Next Button to Card 4. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Your card is now complete, and it will look something like this: 
 

Learning the Trade… Gutenberg’s life as an inventor was 
based on his training in metallurgy.  He was born into a 
wealthy family and lived along the banks of the River Rhine in 
Mainz.  His father and uncle served in official capacities for 
the Archbishop of Mainz’s mint.  Historians assume that 
Gutenberg learned the art of precision metalwork from 
making gold and silver coins. 
 

 

 
The Famous Gutenberg Bible… The first major printing project 
Gutenberg completed was the production of over 300 copies of a 
42-line Bible.  Experts believe that Gutenberg printed the Bible in 
ten sections.  He probably had enough type to set up about 130 
pages at one time.  The Bible had 641 sheets, and most of its pages
contained 42 lines in two columns.  In total, there were 1,282 pages 
bound together in a two-volume set.  This printing project was an 
enormous undertaking: Gutenberg used over 400,000 pieces of 
type to accomplish this feat. 
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Save your stack and take a break, or continue with Card 5. 
 
To recap, in Card 4 you 
• Used the Oval Tool to create a Graphic Object 
• Added a frame to a Graphic Object 
• Added a Path Animation and sound 
• Set a background sound 
• Created a hidden Graphic Object 
• Added a Hypertext link from a Text Object to show the hidden Graphic Object 
• Imported a Text file 
• Used the Hide/Show2 New Button Action 
• Used the Cookie-cutter effect to create a title 
• Deleted cards 
• Added a movie to the card 
• Copied and pasted navigation Buttons 

Movable Type Printing Press and E-Text in the Modern 
World…  The power of printed text during the Renaissance is 
comparable to the impact of today’s electronic text.  The movable 
type printing press wielded enormous influence over every aspect 
of culture and civilization.  The invention of movable type was 
especially revolutionary for people of privilege and education.  
While most of Europe remained illiterate, the fortunate could 
exchange ideas rapidly and accurately through books.  Our 
modern world sometimes appears much the same: great 
advantage is had by the educated and computer-literate. 
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Section 5  Managing Multimedia 

 
Explore these essential skills in this tutorial: 
 
▶ Add a Background 
▶ Use Starfield NBA 
▶ Add Clip Art 
▶ Create a Button from Clip Art 
▶ Add Sound from a CD 
▶ Add a Button 
▶ Go to URL Action 
▶ Record Sound 
▶ Manage Sound Files 
▶ Use the Beveler Effect 
▶ Import an Image from a Scanner 
▶ Use the Box Maker Feature 
▶ Use the Texturize Effect 
▶ Add a Text Object 
▶ Use HyperLogo 
▶ Test the Stack 
▶ Set Presentation Mode 
 
The next card you will create, Card 5, is called “Modern Times: HyperStudio & 
Technology,” will look like this: 
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You will now “hyper leap” from Gutenberg’s press to the twenty-first century’s 
press—the computer!  You will add a background to Card 5 and add a special 
effect that appears when you arrive at Card 5. The special effect is Starfield, a 
new Button action that makes the transition from Card 4 to Card 5 appear as if 
stars are rushing past.  
 
Add a Background 
 
From the Background folder in the Media Window, drag-and-drop the file called 
FutureRoom.bmp onto Card 5 while depressing the Alt/Option key.  Choose 
Import background… in the Drop Options dialog box.  
 

 
 
Use Starfield NBA 
 

1. From the Objects menu, select About this Card… to open the About 
Card - 5 dialog box. 
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2. Under Things to do when, check arriving at this card… to open an 
abbreviated Actions dialog box.   

 

 
 

3. Select New Button Actions… to open the New Button Actions dialog box. 
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4. Choose StarField NBA. 
 

 
 

5. Read the information about this NBA in the Info window and choose Use 
this NBA.  A dialog box opens.  Select Show stars until click or mouse 
press.   

 
6. Choose OK in the New Button Actions dialog box. 

 
7. Select Done in the Actions dialog box and OK in the About this Card 

dialog box to return to Card 5. 
 

8. Press Ctrl < or Command < to return to Card 4; select the Browse tool, 
and click the Button to move to Card 5 and test the transition you just 
created. 

 
9. Revert to Edit mode by using the shortcut, Shift-Tab. 

 
Add Clip Art 
 
From the FutureRoomEquipment.bmp file in the Clip Art folder, use the Lasso 
Selector tool to add computer equipment and accessories to the background as 
seen on the illustration of Card 5 below.  Choose anything you like, but be sure to 
include the radio because we’ll use it later. 
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After you’re finished equipping and decorating, let’s Button on the radio, and 
have it play your favorite music from a CD. 
 
Create a Button from Clip Art 
 

1. From the Objects menu, select Add a Button… to open the Button 
Appearance dialog box. 

 
2. From the Type palette, select the Expanding Area Button (number 7). 

 

 
 

3. Click Position, and when the four-headed arrow cursor appears, move it to 
the radio frame and click once. 
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4. When the dialog box opens to confirm that the Button’s shape has been 
defined, choose OK. 

 

 
 

5. When the Button Appearance dialog box reappears, choose OK and the 
Actions dialog box will open.   

 
Add Sound from a CD 
 

1. From the Things to Do column, select New Button Actions… to open the 
New Button Action dialog box. 

 
2. Place a favorite music CD in the CD-ROM drive.  Make sure the CD 

Player is turned off (not just minimized). 
 

3. From the Names window, select CD Play and click Use this NBA. 
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4. The CD Player Setup dialog box will open. 
 

 
 
Next, you will set the Button to play a one-minute sequence from track 03 of your 
CD. 
 

5. The dialog box contains several buttons to make settings and windows 
that show the CD play time.  Notice that when you arrive at this box with a 
CD in the CD-ROM drive, Track will read 01, and Time will read between 
2:00 and 3:00 seconds (the audio on the CD doesn’t actually begin at 
0:00).   

 
6. Set Track to 03 (notice that the Set Start time changes). Click Set Start. 

 
7. Click Set End and adjust the time upwards by approximately one minute 

(for this example, it’s not necessary to be precise). 
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8. Choose Options. Notice that the CD Player Options dialog box opens 

and lets you quickly set a track or enter the times to start and end a 
selection.  Using Options, you can also create another Button for Pause, 
Stop, etc. 

 

 
 

 
9. When you have completed your settings, choose OK. 

 
10. Then close the rest of the dialog boxes by clicking OK, and then Done. 

 
11. Select the Browse tool and click on the radio to play the music.  Notice 

that the Expanding Area Button Type selects the object you click on.  In 
this case, it selected the radio frame, but not speaker.   

 
 
Click on the radio’s frame, not the speaker, to play the music.  When you are in 
Edit mode, the outlines of the Button show up on the image to let you know 
where to click. 

 
 
 
 
 
 
 
 
 
 

 

From ENIAC to Notebooks… The first computer, ENIAC 
(Electronic Numerical Integrator and Computer), was called an 
electronic calculator; it occupied a room measuring 30 x 50 
feet and weighed almost 30 tons.  The 18,000 vacuum tubes in
its mechanism would often overheat and shut down the 
computer.  Today’s Palm Pilot now does more calculations, 
faster, and more reliably than rooms full of the old apparatus. 
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Now, you’ll create a Button that will connect you directly to the Smithsonian 
Institute Internet site where you can search for more information about ENIAC. 
 
Add a Button 
 

1. Create a simple Button using the Rounded Rectangle Type (Number 1).  
Choose a background color to match the desk and a contrasting name 
color.  Name the Button “ENIAC.” 

 
2. Click OK.  Resize the Button and move it to fit over the second desk 

drawer. 
 

 
 

3. Click outside the Button to set it in place and open the Actions dialog box.   
 
 
Go to URL Action 
 

4. Under Things to Do, select Go to URL….  
 

5. The Go to URL dialog box will open asking you to enter the URL of the 
site to which you want to go when the Button is clicked. 
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6. Type in the site, “http://americanhistory.si.edu” and choose OK.  Then 
choose OK, and Done to return to Card 5. 

 
7. Select the Browse tool and click on the ENIAC Button.  An Internet 

window will open immediately and connect you to the Smithsonian 
National Museum of American History where you can learn about the 
history of computers and find out more about ENIAC from an original war 
document press release (Choose Search Our Site). 

 
Save your stack now. 
 
Next, you’re going to record your own sound passage, using a microphone and 
the Digital Audio Deck dialog box.   
 
Record Sound 
 

1. Create a visible Button (use any type 1-4), add the tape cassette icon, and 
place it as shown (note the outline of the invisible Button in this 
illustration).  Click outside the Button to set it in place, and open the 
Actions dialog box. 
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2. Select Play a sound… to open the Digital Audio Deck dialog box. 
 

3. Using the microphone connected to your computer, click Record and 
speak the following phrase into it, “One small step for man, one giant step 
for mankind.”  Click Stop when you have completed speaking.  Watch the 
green level indicator as you record to verify that it is moving.  If it moves 
only slightly, you are speaking too softly, if it spikes to the top of the range, 
you are speaking too loudly. 

 

 
 

4. Click Play, and listen to the recording.  If you are not satisfied, just record 
again by repeating the steps above. 

 
Tip: In Macintosh, press the Option key while recording for better sound quality. 
 
Manage Sound Files 
 

5. When you are satisfied with the results, save the recording as a separate 
file on disk by selecting Sound stored in: a separate file from the pulldown 
window. 
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The advantage to storing sound files in this manner is that they are not stored in 
the stack and thus, the stack is smaller.  Digitized sound in HyperStudio takes up 
to 5K for 30 seconds.  When stored in a separate file, the amount of memory 
(RAM) needed to open and run your stack is reduced until you access the sound.  
It’s a good idea to store disk-based sounds with your stack.  You can give your 
recording any name.  Here, we used Sound01. 
 

 
 

6. Click Save and Done to return to Card 5.  Select the Browse tool, and test 
the Button. 

 
Next, you’ll decorate the computer room’s bare wall by creating a frame effect 
and importing an image from a scanner (if you don’t have a scanner, you can 
choose clip art from the Media Library). 
 
Use the Beveler Effect 
 
Select any color or pattern from the Colors palette (we chose a gold pattern) and 
the thickest setting in the Line Size dialog box.  Using the Rectangle tool, draw a 
rectangle on the back wall of the computer room above the shelf.  Next you’ll add 
an effect to make the box look like a picture frame. 

 
1. Using the Square Selector tool, capture the rectangle you just drew. 
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2. From the Edit menu, select Effects, then HyperStudio Effects, then 
Beveler… to open the Beveler dialog box. 

 

 
 

3. Experiment with the settings until you find the effect you prefer.  We 
selected Flat and Inverse with a width of 12.  Choose OK. 

 

 
 

Now you’ll put a picture in the frame. 
 
Import an Image from a Scanner 
 

4. Select a picture or photo to scan, and place it in the scanner following the 
manufacturer’s instructions.  Set the scanner at a resolution of 72 dpi. 

 
5. From the File menu, select Add Clip Art…, and when the dialog box 

opens, select TWAIN scanner or video and choose OK. 
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6. The scanner will activate automatically, and the image will appear within 
the Clip Art dialog box so that you can manipulate it as you would any clip 
art image.  If you don’t have a scanner, choose any clip art image or 
photograph from the Media Library now. 

 
7. Select the image and choose OK.  Resize and position it within the frame.  

Your final product should look something like this: 
 

 
 

Save your stack now. 
 
You’re going to add three more items to Card 5: a functioning clock, an image of 
computer users who work and play in the room, and a title.  You will use 
HyperLogo, a scripting language easy enough for a beginner to use, to create the 
digital clock on which the time will be displayed.  Then you will create a Button to 
click to show the time and add the HyperLogo commands to accomplish this.   
 
Use the Box Maker Feature 
 
You’re going to create a digital clock, so let’s add a scratch card to the stack by 
pressing Ctrl N or Command N. 
 

1. From the Colors palette, select any bright color. 
 

2. From the Line Size dialog box, select medium. 
 

3. From the Extras menu, select Box Maker.  A crosshairs cursor appears 
on the card.  Click the mouse and drag a small rectangle on the card.  
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Release the mouse and a three-dimensional box will appear on the card.  
Without clicking the mouse, drag the four-headed arrow cursor around 
until you achieve an effect like this: 

 
 

4. Click the mouse to set the figure in place. 
 

5. Remove the extra lines by selecting the Eraser tool, then white.  
Remember, if you make a mistake, click Edit and select Undo.  You can 
also use the Magnifying Glass to enlarge areas.  Now your box looks like 
this: 

 

 
 

6. Select the Paint Bucket Fill tool to fill in two areas of the box. 
 

 
 
Next, you’ll add texture to the outside of the clock. 
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Use the Texturize Effect 
 

1. Capture the box using the Lasso Selector tool. 
 

2. From the Edit menu, select Effects, HyperStudio Effects, and Texturize… 
to open the Texturizer dialog box. 

 
3. From the drop-down menu, select Sand.  Experiment with the two slider 

bars to see how the effect changes.  For the example, we set the Relief 
slider bar in the center and the Scale slider bar halfway between the left 
and center.  Try checking Invert and changing the direction of orientation.  
The example leaves Invert unchecked and the direction is NW.  Choose 
OK.   

 

 
 
 

4. Change the background color on the work card to black (or any other color 
other than white and the box color) using the Paint Bucket Fill tool.  (This 
is so you can select and transfer the white area of the box as well as the 
rest to Card 5.  If you don’t do this, the white area on the clock will transfer 
as transparent.)  

 
5. Capture the box using the Lasso Selector tool and copy it using Ctrl C or 

Command C.  Return to Card 5, press Ctrl V or Command V and move the 
box onto the desk. Delete your scratch card. Your card should look 
something like this:  
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Add a Text Object 
 

1. Press Ctrl T or Command T to create a Text Object.  Resize and move it 
to fit over the face of the clock, and click outside of it to open the Text 
Appearance dialog box. 

 

 
 

2. Uncheck Draw scroll bar, Scrollable, and Draw frame.  Name the Text 
Object Time. 
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Use HyperLogo 
 

3. Click Actions… and select Use HyperLogo… in the Things to Do list. 
 

 
 

4. The HyperLogo and Click Programming dialog boxes open together.   
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5. In the Click Programming dialog box, select Callbacks and choose 
SETFIELDTEXT from the scrollable window that appears at the right.  
When you choose it, it automatically appears in the window above, along 
with several parameters that must be completed. 

 
6. Press the Ctrl or Command key and click the I-beam cursor on the 

highlighted word “card.”  A pop-up window with two options will open.  
Choose the [ ] option.   

 

 
 

7. The phrase “textitem” now becomes highlighted.  Press Ctrl or Command 
while clicking the I-beam cursor on the word and the pop-up window 
appears again.  This time, choose <use keyboard>.  Click the I-beam 
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cursor on the word “item” and it will disappear.  Type “Time (a double 
quotation plus the word Time), then press Ctrl or Command, click the I-
beam cursor on Value, select <use keyboard>, and enter LAST TIME.  
Choose Enter and the entire phrase appears in the HyperLogo Script 
dialog box above.  It should look exactly like this: 

 

 
 

8. Now set a parameter that will show the time for five seconds.  In the Click 
Programming dialog box, select Flow of Control and select WAIT from the 
drop-down list to the right. 

 
9. Press Ctrl or Command and the cursor on the word “expression” and 

select <use keyboard> from the drop-down menu that appears.  Enter 900 
(HyperLogo for 15 seconds). 

 
10. Choose Enter, and the second line of HyperLogo will appear in the 

HyperLogo Script dialog box.  It should look like this: 
 

 
 

11. To make the time disappear, return to the Click Programming dialog box 
and select SETFIELDTEXT again.  This time, enter [ ] as above and “Time 
as above, but for “value” use the keyboard and type “ (one double 
quotation mark).  Choose Enter, and all three lines of HyperLogo will 
appear in the HyperLogo Script dialog box. 
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10. Click on the X in the upper right corner to close the dialog box.  Answer 
Yes to saving changes, and return to the Actions dialog box.   

 

 
 

 
11. Select Automatic timer… in the Things to Do list. 

 
12. In the Automatic Timer dialog box, mark Activate button after card is 

shown and set the time in the window to 3.0 seconds. Choose OK. Then 
Choose Done and OK to return to the card. 
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To text the clock, move to Card 4 and then back to Card 5.  The time will 
appear on the clock face three seconds after arriving at the card and then it 
will disappear 15 seconds later. 

 

 
 

Finally, finish Card 5 by adding the Computerpeople.bmp from the Clip Art Folder 
in the Media Library.  Then add the title, “Modern Times: HyperStudio 
&Technology,” to the bottom of the card.  We used 14 pt Architect Bold in dark 
blue. 
 
Test the Stack  
 
It’s time to test the stack to make sure that all of the features and actions work 
correctly.  Return to Card 1 by clicking Move and selecting First Card or use the 
shortcut, Ctrl/Command 1. Select the Browse tool and work your way through the 
stack, testing the Buttons, Hypertext links, and Text and Graphic Object actions 
as you go.  If an object needs to be adjusted, double-click it with the Edit/Selector 
tool to reopen the Appearance dialog boxes, and make your changes. 
 
Set Presentation Mode 
 
Now you’ll make some changes in the Preferences dialog box to get your stack 
ready to share with others. 

 
1. Open the Preferences dialog box by clicking Edit and selecting 

Preferences. 
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2. Select Presentation mode… to open the Presentation Options dialog 
box.  Select a color.  This color will surround your card on the monitor 
screen so desktop commands cannot be clicked inadvertently.  Deselect 
Show the title bar, and choose OK to return to the Preferences dialog 
box. 
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3. Lock all Text Objects by clicking Extras and selecting Text Field Tamer. 
Select Read Only and Entire Stack. 

 
4. Hide the Menu bar on all cards except the card you are currently on by 

clicking Extras and selecting Menu Tamer. Hide the Menu bar on the 
current card by pressing Ctrl/Command M. 

 
To recap Card 5, you 
 
• Used Starfield NBA 
• Created a Button from clip art 
• Added sound from a CD 
• Used the Go to URL action to link to the Internet 
• Recorded sound 
• Learned how to manage sound files 
• Used the Beveler effect 
• Imported an image from a scanner 
• Used the Box Maker feature 
• Used the Texturize effect 
• Used HyperLogo 
• Tested your stack 
• Set up the stack for presentation 
 
 
A Brief History of Writing…  The Lascaux Cave paintings and chiseled 
hieroglyphs are early examples of humankind’s inherent desire to communicate, 
create, and achieve immortality.  The illuminated manuscript was considered a 
revolution of the imagination.  Gutenberg’s invention of movable print allowed 
civilization not only to convey meaning, but also to share it widely.  And, now, in 
this modern age, we transmit ideas for personal or business use through 
personal computers and multimedia software. 
 
The leap from cave to computer is a long evolution of language, symbols, and 
communication.  The next leap is surely being worked on, and will introduce even 
greater advantages in saving and sharing our ideas and crossing cultural 
boundaries. 
 
Now that you have experimented with the HyperStudio features, the possibilities 
of manipulating text, graphics, sound, animation, video, and the Internet with this 
multimedia presentation and authoring tool are endless. 
 
We hope that by moving through “A Brief History of Writing,” you have become 
familiar with the program and with HyperStudio’s hallmarks: exploration, 
invention, expression, knowledge, construction, and great fun in communicating.  
Welcome to the HyperStudio community! 
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Chapter 6 
HyperStudio Shortcuts 

 Windows  Macintosh 
Ctrl A Add Clip Art Command A 
Ctrl B Add a Button Command B 
Ctrl C Copy Command C 
Ctrl D Show Media Window Command D 
Ctrl E Export Screen/Text Command E 
Ctrl F Find Text Command F 
Ctrl G Add a Graphic Object Command G 
Ctrl H Home Command H 
Ctrl I Import Background/Text Command I 
Ctrl J Jump to Card Command J 
Ctrl K Restore Standard Colors Command K 
Ctrl L Hypertext Link Command L 
Ctrl M Hide or Show Menu Bar Command M 
Ctrl N New Card Command N 
Ctrl O Open Stack Command O 
Ctrl P Print Command P 
Ctrl R Record in Tape Deck  
 Export WebPage Command R 
Ctrl S Save a Stack Command S 
Ctrl T Add a Text Object Command T 
Ctrl V Paste Command V 
Ctrl X Cut Command X 
Ctrl Y Text Style Command Y 
Ctrl Z Undo Command Z 
Ctrl 1 First Card Command 1 
Ctrl 9 Last Card Command 9 
Ctrl ~ Back Command ~ 
Ctrl > Next Card  Command > 
Ctrl < Previous Card Command < 
Ctrl;  Preferences Command;  
Ctrl + Bring Object Closer Command + 
Ctrl Shift + Bring Object to Front Command Shift + 
Ctrl - Send Object Farther Command - 
Ctrl Shift - Send Object to Back Command Shift - 
Ctrl Shift Reveal Invisible Buttons Command Option 
Shift Tab Toggle Browse/Edit Tools Shift Tab 
Delete Remove Selection Delete 
Alt F4 Exit HyperStudio Command Q 
Ctrl Shift F Next Occurrence of Word Command Shift F 
 Make Text Larger Command = 
 Make Text Smaller Command - 
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Graphic File Formats Supported 

General Sound Movie Files Animation Other 

PIC WAV 
(Must have 

extension, even 
in Macintosh) 

QuickTime GIF’s 
(Numbered 
images can be 
imported as 
separate 
frames, e.g. 
pic01, pic02, 
etc.) 

TIF aifc Some AVI 

On-screen Live 
Video and 
Laserdisc/DVD 
Built-in for AV 
Macs and PC 
capture card or 
digital video 
cards (with built-
in capabilities) 

JPG mp3 MPEG 
(Macintosh only)

Certain AVI 
material 

PCX snd 

BMP AIFF 
(Windows and 

Macintosh) 

Laserdisc/DVD 
image Capture 
(Pioneer CAV 
and CLV 
format) 

GIF System 7 
Resource 

(Macintosh) 
PCX Soundedit 

MIDI 
MPEG 

(Macintosh only)

Apple Quick 
Take digital 
cameras and 
scanners 

PSD Kodak digital 
camera on 
Windows 

TGA Casio QV series

WMF 

TWAIN scanners 
and other TWAIN 

devices 

TWAIN 
supported 
devices 
(Windows only)

Some photo CD 
images 

depending on file 
format 

Macintosh 
supports PICS 
and MacPaint 
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Chapter 7 
Tips and Tricks 

 
 
Animation 
 

• You can import and play GIF animations from the Internet.  If needed, you 
can set a transparent color (the animation background) from the Animation 
dialog after importing the animation.  

 
• If you need to animate one object a number of ways, copy what the 

animation action is attached to (the Button, for example) and paste this 
object on the cards.  Then, from each object, open the animation and 
select New Path… from the Animation dialog box.  This is much faster 
than re-selecting the file that contains the animation for each copy.  

 
• You can animate anything you can put on your card.  Animating small Text 

Objects without scroll bars, or painted text can add a lot of visual appeal to 
a card.   

 
Buttons 
 

• If you copy a Button that has an icon from one card and paste it onto 
another card, both the Button action and the icon will be copied.  Buttons 
placed over clip art are different.  Only the Button will be copied—not the 
artwork. 

 
• You can see the outline of any invisible Buttons if you press the Command 

and Option keys at the same time (Macintosh) or the Control and Shift 
keys at the same time (Windows).  This causes the Button to “flash” on 
and off.  The Edit mode or Button tool does the same thing, but when the 
background is dark you won’t be able to see the Button outline.   

 
• Wait until your stack is finished before attaching Buttons, but leave a 

space in the same spot for the Button on every card.  Make the first 
Button, choosing the transition you want between cards.  Use the Ctrl C or 
Command C, then the Ctrl V or Command V to copy the Button on every 
card.  You only need to copy the Button once, then use paste as many 
times as needed.  This pastes the Button appearance as well as the 
transition.  This is a great time saver and gives your stack more uniformity. 

 
• When you use a Button to go to “Another card,” wait until the stack is 

finished to assign the other card.  Use the Ctrl or Command < or > 
commands to move between cards until the stack is finished.   
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• To remove a Button from a card, select it with the editing tool. When you 
see the red dotted lines, press the Delete key.  This also deletes all the 
associated actions. 

 
• When editing a Button, you can go directly to the Button Actions Menu 

without going through the Button Appearance menu.  Press the Ctrl or 
Command key while you double-click on your Button with the editing tool. 

 
• Many of the sounds included in HyperStudio are designed for Buttons.  

These sounds signal the user that the Button has been clicked. 
 
Clip Art and Graphic Objects 
 

• When you’re designing a card, use a blank card as a “palette.”  This card 
can be placed at the end of your stack or next to the card you are working 
on.  This gives you a handy place to practice without making changes to 
your actual stack.  These pages can be placed in a special stack if you 
want to use the ideas again.  

 
• To resize clip art, select the image with the Square Selector tool. Grab a 

corner (or a side) of the selected area (your mouse will change from the 
four-headed arrow to the double-headed arrow cursor) and drag the 
mouse to size the selection. You can make an object double its original 
size or shrink it to half. 

 
• HyperStudio’s new Media Window (click Options on the tool bar) makes 

adding art to your stacks easy.  Make a folder labeled with your current 
project, add all of the art you need to the folder, then save it in the Media 
Library folder for HyperStudio.  When you are creating your cards, click 
Options, Show Media Window, and then use the top menu bar to bring up 
your folder.  All of your gathered art can be easily applied to the card using 
HyperStudio’s new Drag-and-Drop feature. 

 
• Graphic Objects cannot be manipulated and colored as easily as clip art.  

To make a Graphic Object, first bring in the art as clip art.  Size, rotate, 
change colors, etc. then, using the Lasso tool, select the art.  Click 
Objects, then select Create a Graphic Object….  A dialog box will appear 
asking, “Do you want to turn the selected part of the screen into a Graphic 
Object?”  Choose Yes.  It’s a good idea to make a copy of the art first, 
then change the copy into the Graphic Object.  You will still have the 
original clip art handy if you need to recolor or change the size.   
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Color 
 

• Use the Standard Colors (Ctrl K or Command K) command only on a plain 
card.  Using this command to reset the color palette can change the color 
of objects or backgrounds on an active card. 

 
• Double-clicking on an individual color in the color menu when it's torn off 

will let you reassign that color by choosing your favorite from the 256-color 
palette. Double-click a color in this 256-color palette, and you can choose 
from myriad possibilities.   

 
• When a Button is highlighted, choosing a color from the Colors menu will 

set the text color inside the Button.  
 

• You can manipulate all the color pixels in any highlighted area (use the 
Lasso tool, Square Selector tool, etc.).  When the area is highlighted, 
choose Edit, Effects, and Replace Colors….  You then have the option of 
either replacing all of one color with another, or swapping two colors.  
Replacing is an easy way to change a blue image to a red one without 
using the fill tool or the magnifying glass.  The exchange color option can 
quickly "invert" an image.  This option works best with the lowest color 
option. 

 
• Importing a Background in HyperStudio sets the colors for that card. 

Adding clip art doesn't. Once you've got a color set you like, you can click 
Objects, About this card…, and check "Lock colors.”  With the colors 
“locked,” using another background won't change the basic color set.   

 
• To use color to highlight an area in a piece of clip art, use the Magnifying 

Glass tool to make sure the area is outlined with no gaps, then apply solid 
color (use the Paint Bucket Fill tool) or a Gradient (from the Edit menu, 
choose Effects, then Gradients…).  With complicated colors, this can be 
easier than trying to replace or exchange colors. 

 
• With some objects, you cannot use the Paint Bucket Fill tool or other color 

tools to recolor the object.  To get around this, fill or replace the color of 
any shape by highlighting the shape (a box or circle in the center of 
another object, for example), then choose Edit, Effects, and Gradients…. 
When the gradient dialog appears, select the same color from the two 
palettes and press OK. The selection is filled with a gradient of a single 
color.  Of course you can also select a gradient with two shades.   

 
• Look at the color of your Eraser tool (on the color palette) before you 

make a new card.  The new card’s background color will be the same 
color as the eraser. 
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Copy/Paste 
 

• You can quickly copy Buttons as well as Graphic or Text Objects and 
paste them in the exact spot on a new card:  
1. Click the object or Button to highlight it.   
2. Command C /Ctrl C copies. 
3. Command V / Ctrl V pastes. 
4. Command < or > / Ctrl < or > moves between cards. 

 
You can repeatedly paste without recopying the object if you are pasting 
the same object.  This is an excellent way to copy Buttons and transitions 
between cards.  See the tip under Buttons. 

 
• In Windows, hold down the Ctrl key while dragging a highlighted object or 

area to make a copy without moving the original.   
 
E-Mail For Your Stack User 

 
• You can create a Button that prompts the user to send e-mail.  First create 

a Button using the New Button Action NetPage NBA.  Instead of entering 
a URL in the NetPage NBA dialog, you enter mailto: followed by your e-
mail address (no space or comma between the colon and your address).  
When users click the Button, their web browsers launch and prompt them 
to send mail to your or anyone’s address. This works with 'FTP' (File 
Transfer Protocol) commands for the Internet also. 

 
HyperLogo 
 

• To edit a Button that contains a HyperLogo script, go directly to the 
HyperLogo script editor by pressing Ctrl or Command while you click on 
your Button with the Browse tool. 

 
I’m an Experienced User Setting 
 

• If you select I’m an experienced HyperStudio user (click Edit, then 
Preferences), you can extract sounds from other stacks, programs, or any 
files having a sound. 

 
Moving from Card to Card 
 

• Test out the card (Button) transitions by using the Try It button (from the 
Transitions dialog box) while you design your stack.   

 
• Buttons are a great way to add interactivity to your stacks, but you can 

also add button-like actions to Graphic and Text Objects (or any text within 
them), or even the card or stack itself.  The Actions dialog box is attached 
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to virtually every object.  To set Actions to leaving or opening a card or 
leaving or opening a stack, click Objects from the menu bar and choose 
About this Card... or About this Stack.... 

 
• You can create interesting effects by using certain Button transitions.  For 

example, you can have new text revealed if you use a Left to Right 
transition. The Dissolve transition allows objects to appear magically. You 
can also apply transitions to Text Objects using the HideShow NBA.  

 
Presentation Mode 
 

• To prepare your stack for presentation, create a polished appearance by 
picking a solid desktop color or desktop picture. To hide HyperStudio's 
Title Bar.  Click Edit then the Preferences box.  Make text boxes read only 
(so the cursor doesn’t blink), and hide the menu bar by using the Menu 
Tamer Extra. To hide the menu bar on the card you are on, press Ctrl M or 
Command M.  In presentation mode, the menu bar and the stack name 
and card number will be at the top left of your computer screen and not 
immediately above the card. 

 
 
Sharing Stacks 
 

• It's a better idea to connect smaller parts of a stack (use Buttons) rather 
than creating one mega-stack.  Think about your project as a book divided 
into chapters. This also allows users with less computer memory to play 
your stacks. 

 
Sound 
 

• The CD Play NBA is a great way to add sound to a card.  To use this New 
Button Action, be sure the CD is in your CD player, but the player is OFF 
(not minimized).  The Set Start and Set End buttons do not need to be 
clicked to set the start/end time.  Clicking the Set Start and Set End 
buttons automatically sets these times to the Track Time, which you may 
not want.  Remember to set the Set Start time at about 2 seconds 
(00:02:00) instead of 0 seconds (00:00:00).  Very few tracks begin at 
exactly zero.  

 
• For Macintosh users, hold down the Command key when you start 

recording to get better recording quality. Holding down the Option key will 
give you the best quality.  While compression saves disk space, it also 
diminishes recording quality.  HyperStudio on Macintosh automatically 
compresses sounds at a ratio of 6:1.  Pressing the Command key 
changes this ratio to 3:1. 
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• It is possible to play two sounds at the same time.  Set your Preferences 
to I’m an experienced HyperStudio user.  Then, select Background Sound 
from the Audio Deck screen.  A background sound will keep playing 
regardless of whether you start another sound.  QuickTime audio also has 
a Background Sound option in the QuickTime movie dialog. 

 
• HyperStudio will begin recording sound as soon as you click on record, 

and will keep recording until you click the mouse or press any key. Speak 
immediately and click the mouse the instant you are finished to avoid 
recording dead space, which uses up memory. 

 
• When recording in HyperStudio, there are Disk-based sounds and Stack-

based sounds.  If you choose Disk-based sounds at the Audio Deck 
screen, then multiple stacks can use the same sound.  The sound file is 
stored on disk and brought into memory only when HyperStudio needs it. 
The sound is not stored in the stack.  Stack-based sounds allow multiple 
Buttons in a stack to share that same sound. 

 
Stack Hints 
 

• When you are working on a stack, many of the toolboxes or other helpful 
dialog boxes appear right in the center of your card.  You can move these 
out of the way by dragging them (click their top bar).  Easily dragged 
boxes include the Media Window and the Magnify tool preview box.  

 
• If you are creating a large presentation, create a “Home stack” and a 

separate stack for each part of the presentation.  Buttons will carry the 
user from stack to stack or back to the “Home stack.”  This works 
especially well with information that is likely to change.  You can change 
only one section, or add new stacks with new information very easily.   

 
• Stacks in thousands or millions of colors can take advantage of JPEG 

compression to reduce the size of the file.  Complete all editing of the 
background before selecting the option "Highest Compression for 
Backgrounds" in the Preferences Menu. 

 
Starting HyperStudio with Macintosh 
 

• On Macintosh, if you make a HyperStudio Alias, and put it in the Startup 
Items folder; then each time you start your Mac, you will go directly to 
HyperStudio. You can still choose Quit and go back to the Finder.  Make 
Alias is found in the File menu of the Finder. The Startup Items folder is in 
the System folder. 
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Text and Text Objects 
 

• Use Painted Text to identify objects on your art palette (see the section 
under clip art and Graphic Objects), but use Text Objects for all of the text 
in your stack.  A Text Object uses very little memory compared to Painted 
Text, and can be easily changed.  If you need text that will not go into a 
Text Object, save the text as a Graphic Object instead of Painted Text.   

 
• If italicized characters seem to get clipped off, select the text by 

highlighting it, and then choose the same color you are already using.  
This forces HyperStudio to redraw the letters.  If the last letter appears 
clipped, add a space after it. 

 
• You can make text in a Text Object perform an action when clicked on 

(this is known as a Hypertext Link) by highlighting the text and pressing 
Ctrl L or Command L.  Select Add Link to create the link, then select 
Actions... to assign the word(s) an action.  To see a complete example, 
take a look at the Hypertext stack in the Techniques section. 

 
• If some of your text seems to disappear, use the Text Object tool or the 

Edit/Selector tool and make sure the Text Object box is big enough.  If the 
text just seems to be “slipping,” you probably have an extra space on the 
line before or after the text.  Use the Browser tool and the cursor to check 
for empty space.   

 
• With the HideShw 2 NBA (hide/show an object), you can make Text 

Objects appear on your screen when the user clicks a Button.  With 
HideShw 2 NBA or the Multiple HideShow (for more than one Button), you 
can also use transitions.  With practice, you can make words appear to 
scroll in any direction, at any speed, or perform other interesting actions. 

 
• If you use the Hide/Show feature, attach the same feature to Objects, 

About this Card…, Things to do when leaving this card…, but select hide 
the Text Object.  This prepares the card with the features hidden for the 
next user. 

 
Tools Menu 
 

• Press Shift-Tab to go back and forth between the Browse and 
Edit/Selector tool.  This is handy when you are editing features that you 
need to try out with the Browse tool. 

 
• Double-click on the Square Selector tool (when the Tools menu is torn off) 

to select the entire background. This is a good way to copy all the clip art 
or the background.  It will not copy Text or Graphic Objects or Buttons.  
Use Copy Card (from the Edit menu) to copy the entire card. 
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• When you select something with the Lasso, you will see dotted red lines.  

This means that the image is floating on the card and is ready to be 
moved.  Be careful not to click the mouse or drag the art until you see the 
four-headed arrow cursor.  Moving the mouse slowly across the image will 
change the cursor to the pointer.  If you accidentally move or paste the art, 
you can choose Undo from the Edit menu or press Ctrl Z or Command Z. 

 
• Hold down the Shift key to draw a straight line with the pencil, the 

paintbrush, or the spray paint can.  Hold down the Shift key when you use 
the Eraser tool and the tool will erase in a straight line. The horizontal or 
vertical direction is determined by which direction you first move the 
mouse. 

 
• When you use the Lasso, whichever color is first clicked with the end of 

the rope (usually on the outside when you lasso something,) will be 
transparent on the inside of the clip art when you move it. For example, if 
the white background of a white-paned window is clicked first, the window 
will become transparent.  This can be a spectacular effect if one clip art 
object is pasted over another (a “transparent window” over a garden 
background, for example.)  Press the Option (Macintosh) or Alt (Windows) 
key while using the Lasso to temporarily disable this feature. 

 
• If you select an object with the Lasso tool and the object has what seems 

to be a border around it, there is probably a color on the background that 
you can’t see.  Change the color of the background.  Use the Paint Bucket 
Fill tool (not the Edit, Erase Background command).  You will instantly see 
the background of the clip art that needs to be erased before it can be 
closely lassoed.  To override this feature, you can bring in clip art with the 
Lasso tool.   

 
• The Lasso tool offers creative and interesting effects.  For example, if you 

click the end of the Lasso tool (the rope end) in a colored area while 
holding down the Ctrl key, the entire area will be copied, and can be 
moved, re-colored, then replaced.  If the clip art is on a black background 
with a lot of connecting black lines as part of the art, clicking the Ctrl key 
and the Lasso tool rope end in a black section of the art will produce a 
“negative” image of the clip art.   

 
• Hold down the Ctrl key with the magnifying tool activated (but not clicked) 

to change the cursor to a grasping hand.  This allows you to scroll the 
screen by simply dragging in any direction. 
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Undo Command 
 

• You can press the Ctrl Z or Command Z to undo mistakes immediately 
after they were made. If you click the mouse or do other actions before 
you press Ctrl Z or Command Z, it will be too late to use undo. 

 
• When you are trying something complicated with a card, insert a new card 

behind the card you are working on.  Use the backup card as a practice 
card before building the original card. 

 
Video 
 

• To have just your movie screen dissolve after the last frame, in Actions, 
Places to Go, choose Another card.  Select the card currently displayed 
(the one the movie plays on) as the other card.  After your QuickTime 
movie plays, the last frame of the movie will dissolve.  Be sure Show first 
frame and Erase when done are not checked.  

 
• You can resize QuickTime movies, QuickTime VR panoramas and object 

movies within HyperStudio by dragging the side or corner.  Note that 
making a QuickTime movie bigger will slow it down. 
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HyperStudio Frequently Asked Questions and Answers 
 

 

How do I clear the text field after the GhostWriter NBA has finished typing 
my text? 
 

There are two ways to achieve this: 
 

1. Follow the instructions provided in the text windows of the GhostWriter 

NBA.  Each “@” will have GhostWriter delete one space.  For each 

character and space in the written field, add one “@”.  For example: 
This is a simple 

test.@@@@@@@@@@@@@@@@@@@@@@ 

2. HyperLogo also provides a solution. Use the SETFIELDTEXT 

command.  If you leave the designated text blank, SETFIELDTEXT will 

clear the text field.  For example, your card has a text field named, 

“Text1”.  The script to clear the field would look like this:  

SETFIELDTEXT [] “Text1 ‘ ‘ 
 

 
 

I have registered my application, but every time I launch HyperStudio, I am 
asked to register the program again. What should I do? 
 

This error only occurs when HyperStudio is run on a network volume or under 

some form of desktop security.  Change settings to allow WRITE access to the 

HyperStudio folder, turn off the desktop security program, or deny WRITE access 

to the directory. 
 

Web Server Configuration Note: Web Server Administrator information for the 

HyperStudio Browser Plug-in. 
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This information is useful for configuring several popular Web servers that 

support custom MIME entries with the proper MIME information for serving 

HyperStudio stacks.  Note that your web server may not require all of the 

information given. 

 

Action = BINARY 

File Suffix = .STK 

File Type = * (Try Text if necessary) 

Creator = * 

MIME Type = application/hyperstudio 

 

 

I am unable to Open Stacks dated 2000 and beyond. What can I do? 
 

The best solution is to update to the latest version of HyperStudio at the web site  

http://www.hyperstudio.com.  
 

 

I have installed the HyperStudio plug-in.  But when I try to view my stacks 
on the web I see: 

a) a plug-in icon.  
b) a broken plug-in icon.  
c) a message telling me to locate the appropriate plug-in.  

What should I do? 
 

Try to view the stack locally by opening it directly within a web browser. If this 

works, then direct your Webmaster to our "Server configuration notes" posted on 

the HyperStudio plug-in page http://www.hyperstudio.com.  If you cannot view 

stacks locally, reinstall the HyperStudio plug-in. Use the latest plug-in installer 

from our website. 
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When I try to use the Extras Manager, I am told that I cannot access it 
because HyperStudio is setup to be shared on a network. What do I do? 
 

Update your copy of HyperStudio to prevent this error from occurring again. 
 

 

 

I am trying to update HyperStudio but I get an error message saying, 
“Invalid version selected for the update process.” What happened? 
 

There are two possible causes.  First, you may have downloaded and tried to 

install the incorrect version.  Try the first set of instructions to see if this is the 

case for you. 

 

1. Launch HyperStudio. 

2. Click Help and select About HyperStudio. 

3. Record the version of HyperStudio you are using. 

4. Download and run the appropriate updater. 

 

The second cause is infrequent but occurs when updating from HyperStudio v3.2 

to HyperStudio v3.3.  This only happens on Macintosh.  If this is the case 

proceed with these instructions. 
 

1. Double click on your Hard Drive icon. 

2. Double click on HStudio or HyperStudio for HD folder. 

3. Find the HyperStudio program file. 

4. Make sure that it’s called HyperStudio 3.2 and not HyperStudio 3.1. 

5. If you need to rename the file so that it does in fact say HyperStudio 3.2 and 

run the update with HyperStudio v3.3 again. 
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When I try to load a stack, I get the message, “I'm sorry. The stack file 
cannot be loaded by this version of HyperStudio.” What is wrong? 
 

This error occurs when mismatched versions of the install diskette and CD are 

used in older versions of HyperStudio.  First, verify that the CD and diskette 

versions match.  If they do and the error continues, your diskette is probably 

corrupted.  For a replacement diskette please contact Technical Support at 1-

800-HYPERSTUDIO (1-800-487-3778). 
 

 

I have been saving my stack to a Novell network, and now HyperStudio 
cannot read any of the cards. What’s wrong? 
 

Older versions of HyperStudio have problems with saving to Novell servers. 

Recent versions have enhanced network support. To prevent this problem go to 

our web site and download the latest update from the HyperStudio site at 

http://www.hyperstudio.com. We generally recommend allowing FULL access to 

the directory where the stack files are being saved. When FULL is not an option, 

give the following access parameters: READ, WRITE, DELETE, MODIFY and 

EXECUTE. 
 

 

When I import an AVI nothing happens, or I get an error message that 
states,  “The compression format of the AVI is not supported by 
QuickTime.” What do I do? 
 

HyperStudio uses QuickTime to play back AVI's.  QuickTime has limitations that 

cause compression problems. Older versions of QuickTime may not include the 

compression format used by the movie. These compression settings cannot be 

seen in HyperStudio.  Your video capture software and many third party movie-

editing programs such as Adobe Premiere will allow you change to settings 
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supported by HyperStudio (QuickTime). Please review the supported 

compression formats listed below.  

Cinepak Codec by Radius (most widely supported) 

Intel Indeo (R) Video Interactive 

Microsoft Video 1 

Microsoft RLE 

These compression formats may prevent movies from playing in HyperStudio. 

Indeo Video 5.04  

Intel Indeo (R)Video Raw R1.1 

 

Visit the web site for the manufacturer of the video capture board you are using 

and download the latest drivers.  Go to www.apple.com and check for Apple 

Computer's latest version of QuickTime. With each new update, you'll see 

additional compression formats supported. Additional support for AVI and other 

media formats (MPEG) has been implemented in HyperStudio 4. 

 
 

 

When I create stacks using a PC and open them on my Macintosh, 
resources are missing or out of place. If I create stacks on my Macintosh I 
have the same problem opening them on my PC. What gives? 
 

Differences in versions may result in resources being stored differently.  This can 

cause unresponsive hide/show NBA's, sounds not playing, some graphics not 

displaying or graphics displaying poorly. The resources are not lost when 

opening the stacks in different versions but they can be unavailable. Check the 

HyperStudio Reference Manual for cross-platform information. 
 

To avoid color-handling problems between platforms, create stacks at thousands 

of colors (either 16 bit or High Color). Upgrade the version of HyperStudio 

running on the computers. The current updates for HyperStudio can be found at 

the HyperStudio web site http://www.hyperstudio.com. 
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Why don’t I have any of the Button icons, sounds, and/or NBA’s listed 
within my Sample fields? 
 

HyperStudio accesses all of these files from the HS Samples Library or 
Samples.stk located in the HyperStudio program folder.  If the file is not present, 

copy the stack from the HyperStudio CD to the same location as the HyperStudio 

program. This will bring these items back to the Sample fields. To edit the 

Samples stack, open it up in HyperStudio for complete information. 
 

 

When I set the track times in my CD Play NBA, they do not hold. Why not? 
 

Verify that the track time is set at Absolute. Access this by selecting the Options 

tab in the CD Player Setup dialog box. 
 

 

Why do some imported images in HyperStudio come in too big? 
 

This occurs when certain images are saved at a higher resolution than 72 dpi 

(dots per inch).  If you are creating images, save them at 72 dpi.  Alternatively, 

import images as clip art. Scale the image in HyperStudio, and if desired, convert 

it into a Graphic Object. 
 

 

My multi-user version of HyperStudio used to let me save but no longer. 
What should I do? 
 

Older multi-user versions of HyperStudio provided a 30-day grace period for 

filling out the registration card and sending it in. If you do not have the 

registration information, or are unsure as to whether it has been sent, speak with 

Knowledge Adventure Customer Service at 1-800-545-7677 for further 

assistance, or send e-mail to hyperstudio@education.com.  
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Why can’t HyperStudio find any of my disk-based resources? 
 

HyperStudio stores the location of and "remembers" the complete path to all the 

disk-based sounds and movies used by a stack.  If a stack is moved to another 

computer, the path may be different, and HyperStudio won't know where to look 

for the disk-based resources. 
 

When creating links between multiple stacks or when linking to disk-based 

resources, keep all of the stacks and disk-based resources in the same folder. 

This is important if making a project intended for distribution on CD-ROM. 

Because the volume name or label is often different, the stack links break. Keep 

movies and disk-based resources such as sound, text or graphics, in the same 

folder as the stack. Alternately, store them in a folder at the same level of the 

stack(s) and relink as needed.  

 

 

How do I remove the Title bars? 
 

To hide Title bars 
1. Click Edit and select Preferences (Ctrl/Command ;). 

2. Select the Presentation Mode option. 

3. Deselect the Show the Title Bar option and choose OK. 

 
To hide (or show) the Menu bar for a particular card, press Ctrl/Command M or 

select Hide Menu Bar from the Options menu. 

  
If you want to hide ALL of the menus throughout the stack, use the MenuTamer 

Extra. This Extra will allow you to hide menus for all of the cards in the stack 

except for the current card. Use Ctrl/Command M to hide the menu bar on the 

card you're on. 
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Why can’t I find the Features option in my Button, Text, or Graphic 
Appearance dialog boxes? 
 
To activate this option 

1. Click Edit, and select Preferences (Ctrl/Command ;). 

2. Check I’m an experienced HyperStudio user. 

3. Choose OK. The Features option will now appear in the dialog boxes. 
 
 
How do I make my stack fill the screen? 
 
The default HyperStudio card size is 512x342.  The default size for HyperStudio 

v4.0 is 512x384.  The typical monitor setting is 640x480 or higher, 800x600, 

1024x768for instance.  
 

To convert the existing stack to full screen  

1. Click Objects and select About this stack. 

2. Select Change # of Colors or Size. 

3. From the pull down menu, choose a card size that matches your monitor 

setting. 

This method will stretch your current cards to fit the new card size. However, 

Graphic Objects may distort producing undesired results.  

 
To create a new stack that is full-screen 

1. Click Edit and select Preferences (Ctrl/Command ;). 

2. Select I’m an experience HyperStudio user and choose OK.. 

3. Click File and select New Stack.  

4. HyperStudio will ask you if you want to use the same card size as your 

current stack.  

5. Select no, and choose the card size (and colors) you want to use. 

6. In HyperStudio 4, check Use as default for new stacks. All new stacks will use 

the new settings. 
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Why do imported images in HyperStudio, seem grainy and/or smeared?  
 
Older versions of HyperStudio stacks were delivered at 256 colors. New stacks 

used this color depth. If your images were created in thousands or millions of 

colors, HyperStudio pared down the images to 256 colors, which causes the 

images to lose quality.  Solve this problem by changing the color depth of the 

stack. 

1. Click Objects and select About this stack. 

2. Select Change # of colors or size. 

3. Select the color that matches the display color depth.  

4. Choose OK. 

5. Choose OK again. 
 
 
 
Why won’t HyperStudio accept my registration number? 
 
First, verify that you’re typing in the correct number (be sure that you don’t have 

Caps Lock on).  If it still doesn’t work, contact Customer Service at 1-800-545-

7677 for further assistance or e-mail us at hyperstudio@education.com. 
 
 
When I open a new stack, why does my Menu bar only provide me with 
FILE, EDIT, MOVE, and HELP? (You may only see a black screen as well). 
 
Be sure you are running the HyperStudio program and not the player (stacks to 

go). Older versions of HyperStudio were a two-part install (CD and floppy disks). 

If only the CD was installed, the Home Stack is launching through the 

HyperStudio Player, which is a viewing tool only. This problem was caused when 

you installed only the resource CD. Run the installer from your program floppy 

disks.  
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Alternatively, the stack may have been locked with a password. (Click Edit and 

select Preferences to verify this.)  If the Locked option is grayed out it means 

someone has locked the stack. If you do not know the password and the stack is 

not a commercial application, please contact Technical Support at 1-800-

HYPERSTUDIO (1-800-497-3778) for assistance. 
 
 
 
When I record into HyperStudio, and try to playback my sound, I am told 
that the file is not supported. What’s up? 
 
Update your copy of HyperStudio.  If you still experience difficulties install the 

latest version of QuickTime.  

 
 
 
I cannot print 2 cards per page. Why is every other card in my stack coming 
out blank? 
 
This is a printing related issue that can be fixed by downloading the latest update 

to HyperStudio. This is the only solution. We recommend printing one card per 

page or four cards per page if updating is not possible. In HyperStudio 4, try 

using the print function from within the Storyboard Extra. 
 
 
I am having trouble printing my stacks in HyperStudio. Why does my 
printer just print out blank pages? 
 
Update to the HyperStudio 3.3. It provides improved printing support with 

LaserJet printers. We also recommend updating your printer drivers.  
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Macintosh FAQs 
 
 
I keep getting an error telling me that a duplicate copy of HyperStudio is 
running. I can only have one machine launch HyperStudio at a time. What’s 
wrong? 
 
You are probably using the Apple Bundle v2.0 of HyperStudio, a single user copy 

of HyperStudio. If your Macintosh computers are networked together or to a 

printer, update your copy of HyperStudio from 2.0.92s to 2.0.97s or higher from 

our web site at http://www.hyperstudio.com. 

 
 
When I try to open my stack file, I am told that it is already in use. What can 
I do? 
 
To correct this error, locate the stack file and click on it once to highlight it.  

1. Click on File and select Get info. 

2. Select the Locked box checkbox option at the bottom left of the Get Info 
dialog box. 

3. Open the stack in HyperStudio. 

4. A message appears stating that the stack file is locked and that the user will 

not be able to make any changes.  

5. Choose OK. 

6. Click on File and select Save As. 
7. Save the stack under a new name to a location on your hard disk.  

8. Delete the old stack.   
 
 
 
When I launch HyperStudio, I am repeatedly asked to install QuickTime. 
What should I do? 
 
1. Double click the main Hard Disk icon. 

2. Double click on the System Folder icon. 

3. Double click on Extensions icon. 

4. Locate all QuickTime related files, including QuickDraw3d, and drag them into 

the Trash. 
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5. Restart the computer. 

6. Reinstall QuickTime using the HyperStudio CD. 

7. Restart the computer. 
 
 
 
QuickTime installation will not complete because HP Background could not 
be closed. What can I do? 
 
Copy the QuickTime installer from the HyperStudio CD, to your desktop. Restart 

your machine with all extensions off while holding down the Shift key.  Run the 

installer you copied to your desktop.  When the installation is complete, restart 

the computer before running the program. 
 
 
 
When I record using HyperStudio, the sound seems distorted or scratchy. 
How can I improve the sound quality? 
 
To improve the sound quality, press and hold down the Option key while 

recording in HyperStudio. Already existing sound will not be affected, but you can 

re-record into the tape deck and prevent this problem from occurring again. 

(Caution: Higher quality sound files take more memory.) 
 
 
 
When I view my stack files locally and on the web, my Internet browser 
crashes. What’s wrong? 
 
Check that sufficient RAM (Random Access Memory) is allocated to the 

"Preferred memory" of your browser software. (See Type 1 error below.) 

 
 
When I save my stack to the network, I am told that I do not have enough 
disk space, or that the disk is locked or not online. What do I do? 
 
In earlier versions of HyperStudio, we did not support volumes with more than 
2GB of free space. This is a Mac OS limitation. Update to the latest version of 
HyperStudio from the HyperStudio Web site at http://www.hyperstudio.com. 
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Macintosh Error Messages 
  
Type 1 Errors 
 
Type 1 errors generally refer to the application running out of memory. Try 

allocating more RAM to the "Preferred memory" setting of the program.  
 
To identify available RAM in your system and adjust the Preferred Memory 
 
1. Click on the Apple Menu at the top left corner of the menu bar. 

2. Select Profiler, About this Computer, or About this Macintosh depending 

on which system you have. 

3. The amount of memory (RAM) you have available shows in the dialog box 

that appears. 

4. Locate your preferred browser on your hard drive. 

5. Click on the browser icon once to highlight it. 

6. Click File on the main menu bar and select Get Info. 

7. In the Get Info dialog box, select Memory from the Show: pull down menu. 

8. The Application Memory Requirements is displayed. 

9. Adjust the number in the Preferred Memory text field upwards an additional 

1000 to 4000k. Remember, stay within the limits of your available RAM. 

 

 

Type 1 errors or freezes can also occur when the BlabberMouth NBA is 
selected. 
 
To prevent this error download the updated BlabberMouth II NBA from our web 

site at http://www.hyperstudio.com. Place the new NBA into the "NBA’s and 

Extras" folder located within the "HyperStudio" folder. Allow the new NBA to 

overwrite the old file. Click on the "Disk library" option and select the new NBA 

from this location. Do not select the NBA listed in the "Samples" window. Be sure 

to delete the old BlabberMouth NBA from the Samples library, and replace it with 

the updated one for your convenience.  
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Type 2 Errors 
 
If this error occurs during the startup of HyperStudio 

1. Click on the Apple menu item. 

2. Click on Control Panels. 

3. Click on Monitors and Sound. 

4. Set your monitor color depth to 256 colors or higher. 
 

If the error is not resolved 

1. Double click the main Hard Disk icon. 

2. Double click on the System Folder icon. 

3. Double click on Extensions icon. 

4. Locate all QuickTime related files (including QuickDraw3d) and drag them 

into the Trash. 

5. Restart the computer. 

6. Reinstall QuickTime from the HyperStudio CD. 

7. Restart the computer. 
 

 

For HyperStudio 3.1.7, determine the operating system on your Macintosh. 

1. Click on the Apple menu item 

2. Select About this Macintosh, About this Computer, or Apple Profiler 
3. If you have Mac OS 7.1 we recommend upgrading your operating system to 

at least Mac OS 7.5.3.  

Note: HyperStudio 4 requires a minimum system requirements of Mac OS 8.1 or 

higher. 
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Type 11 and Type 15 Errors 
 
These errors are usually caused by an extension conflict. Restart the machine 

with "Base OS" extensions only.  
 
1. Click the Apple menu item. 

2. Select Control Panels. 

3. Choose Extensions manager. 

4. From the pull down menu in the Extensions Manager dialog box, select the 

Base OS option.  

5. Restart the computer. 

If the problem still occurs, please contact Knowledge Adventure Technical 

Support at 1-800-HYPERSTUDIO (1-800-497-3778). 
 
 
 
Type 22 Error (when using the CDPlay NBA) 
 
If this error occurs while using the CDPlay NBA, download the updated CD Play 

NBA, (version 3.43 or higher), from our web site at http://www.hyperstudio.com. 

The new NBA is located within the "Update library" under the "Macintosh" option. 

Place the new NBA into the NBA’s and Extras folder in the HyperStudio for HD 

folder. Allow the new NBA to overwrite the old file. Be sure to delete the old 

CDPlay NBA from the Samples library and replace it with the new one. 
 
 
 
Type 36 and Type 39 Errors (with HyperStudio v3.2 or older) 
 
These are always disk-related errors. If the error occurs during the installation of 

HyperStudio, contact Knowledge Adventure Technical Support for replacement 

media. If the error occurs while you are saving your stack to a floppy, save it to 

the hard disk first and then save it to the diskette. If necessary, use a new 

diskette.  If this occurs while saving to a hard disk, run some form of system 

diagnostics program, such as Norton Utilities™. 
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Miscellaneous Errors 
 
1. An error prevented the update from completing, (RESU 100) 
 
The HyperStudio application has not been registered. Register the application 

and try running the update again. If this fails, restart the machine with all 

extensions off while holding down the Shift key.  Then, re-register the program, 

and try the update. 
 
 
 
2. "Resource has been modified" error during the update process 
 
Reinstall HyperStudio. Be sure to register the application. Once this is complete, 

restart the machine with all extensions off while holding down the Shift key. Then 

run the updater again. 

 
 
 
Windows FAQs 
 
 
When I launch HyperStudio v3.2 (or older), I am asked for either the 
Paige32 or the Paige.dll (sometimes may be the Vic32 or the Vic.dll). What 
does this mean? 
 
This error is usually caused by using mismatched versions of the install diskette 

and the install CD for older versions of HyperStudio.  First, verify that the diskette 

and CD versions are the same.  The files mentioned in the error message will be 

located on the CD. You might also try copying the .DLL files into the HyperStudio 

program directory and to the Windows System directory.  If this doesn’t work, 

your diskette is probably corrupted.  Contact Knowledge Adventure Technical 

Support for replacement media at 1-800-HYPERSTUDIO [800-497-3778]. 
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When launching HyperStudio, I am given an error that says, "Sorry. Unable 
to access WAV output device." What should I do? 
 
We recommend you update to HyperStudio version 3.2 or higher. Download the 

most recent version of QuickTime, and update your sound card driver.  
 
 
 
When launching HyperStudio, I am asked for the AVICAP32.DLL. How can I 
fix this? 
 
This error only appears in versions of HyperStudio older than v3.2. It can be 

handled one of two different ways.  
 

1. Update to the latest version of HyperStudio as well as the latest version of 
QuickTime.  

 
2. Insert your Win95/98/NT OS installation CD in the CD-ROM drive.  

 
a. Click Start and select Settings. 

b. Double click Control Panel. 
c. Double click on Add/Remove Program. 

d. Click on the Windows Setup Tab (or the NT Setup Tab). 

e. Remove the checkmark from Multimedia. 

f. Choose Apply. 

g. Place the check back in Multimedia and choose Apply, then OK. 

h. Close out the Control Panel and restart the computer. 

 
 
When launching HyperStudio, I am asked to uninstall the program, or I am 
told the shortcut could not find the appropriate EXE file. What do I do? 
 
Older versions of HyperStudio are installed with both a floppy diskette and a CD. 

In this case, you have fully installed the CD, but have not installed with the floppy 

disk.  

 
1. Place the program floppy disk in the [A:] drive. 

2. Double click on My Computer. 

3. Double click on [A:]. 
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4. Double click on the run_last.exe. 

5. Select the Maintenance installation option. 

6. Follow the prompts to complete the installation. 
 
 
When I launch HyperStudio, I am told that HyperStudio requires 256 colors 
to run. What do I do? 
 
HyperStudio requires at least 256 colors to operate. Most PCs are able to display 

at least 256 colors but the driver may need to be updated. 
 
To change the driver the computer is using 
 
Windows 3.X - Contact your computer manufacturer to obtain a 256 color 
video driver and installation instructions.   
 
Windows 95/98 
 
1. Click Start and select Settings. 

2. Double click on Control Panel, then double click on Display. 

3. Click on the Settings tab. 

4. Click the down arrow above the “rainbow” colored line and select 256. 

5. Choose Apply. 

6. If prompted to restart your computer, choose Yes. 

7. If another message appears asking if you wish to keep this setting, choose 

Yes. 
 
Windows NT 
1. Click Start and select Settings. 

2. Double click the Control Panel. 

3. Double-click on Display. 

4. Click on the Settings tab. 

5. Click the down arrow above the “rainbow” colored line and select 256. 

6. Choose Test. 
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7. If the next screen is correct, choose Apply when it returns to Windows. (Do 

not click Apply if this screen appears incorrectly. The setting you have chosen 

is incompatible with your Monitor/Video card. Try a different setting.) 

8. Choose OK.  
 
 
Windows 2000 
1. Click Start and select Settings. 

2. Double click on Control Panel. 

3. Double click on Display. 

4. Click on the Settings tab. 

5. Click the down arrow above the “rainbow” colored line and select 256. 

6. If the next screen is correct, choose Apply and then OK when it returns to 

Windows. 
 
Please Note! If you are not completely comfortable with changing the Windows 

drivers, or if you are not sure the system came with additional drivers, contact the 

vendor that sold you the computer. Drivers are generally free, and the vendor will 

be able to supply the most current driver for the your operating system. 
 
 
 
 
I can’t get the Spell Checker to work in HyperStudio.  I am told that 
HyperStudio cannot find, or cannot open the appropriate dictionary file. 
What can I do? 
 
First, make sure that you have the Dictionaries directory within the Hstudio 

folder. If so, then follow the instructions below. 
  

1. Double click on My Computer. 
2. Double click on [C:] drive. 

3. Double click on Program Files. 

4. Double click on HStudio. 

5. Double click on Dict. 

6. Choose the desired dictionary. 
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7. Click File at the top of the window and select Properties. 

8. Deselect Read Only and select Archive. 
9. Launch HyperStudio and try the Spell Checker again. 
 
 
 
Why doesn't the Windows version of HyperStudio support the 
BlabberMouth NBA? 
 
The BlabberMouth NBA for Macintosh uses the Macintosh Speech Manager 

located within the Extensions folder. Unfortunately, the Windows platform does 

not ship with its own built-in text to speech program. The BlabberMouth NBA is 

included in HyperStudio 4 for Windows and includes support for text to speech 

but a speech program must be acquired separately.  
  
 
 
When I try to play a movie in HyperStudio, the only option I am given is 
"Video for Windows." What’s wrong? 
 
QuickTime installation was not required to run versions of HyperStudio prior to 

3.1. Obtain the latest version of QuickTime and install it 

(http://www.quicktime.com). 
 
 
 
I do not have any of the button icons, sounds, and/or NBA’s listed within 
my Sample fields. How can I fix this? 
 
HyperStudio accesses all of these files from the Samples.stk located within the 

HStudio folder. To add these files to the Samples.stk 
 
1. Click Start and select Find. 

2. Click on Files or Folder. 

3. Type Samples.stk in the Name field. 

4. Verify that Look In displays the [C:] drive. (If not, change it so that it does.) 

5. Choose Find Now. 

6. If you cannot find it on your hard drive, copy Samples.stk from the 

HyperStudio CD to the HStudio folder.  
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When installing HyperStudio, I am told that the "Light.ttf" font file could not 
be copied to the Fonts folder. What happened? 
 
This error only occurs when Microsoft Office is running in the background.  
 
1. Press the CTRL, ALT, and Delete keys on the keyboard at the same time and 

then release them. 

2. The Close Program dialog box will appear. NT and 2000 users need to 

select the Applications tab. 

3. Highlight and close all applications except Explorer and Systray.  (If you close 

either Explorer or System you will have to begin again.)   

4. Highlight the other running applications one at a time and choose End Task. 

5. If a box appears that says, “This program is not responding,” choose End 

Task. 

6. Press the CTRL, ALT, and Delete keys on the keyboard at the same time and 

then release them to open the Close Program dialog box again.  (Repeat this 

procedure until the only programs left are Explorer and Systray.) 

7. Choose Cancel. 
 
 
 
Windows Error Messages 
 
 
I/O Error While Installing HyperStudio v3.2 or older 
 
Manually install the program using the following procedures.  Place the 

HyperStudio program CD and diskette in their respective drives. Do not start the 

program installer. These procedures involve copying files, renaming files, and 

changing file attributes. If you are not familiar enough with your computer to 

complete them, contact Knowledge Adventure Technical Support at 1-800-

HYPERSTUDIO (1-800-497-3778). 
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Copying the HStudio folder from the CD-ROM to the hard drive.  
1. Click on Start.  
2. Click on Programs.  

3. Click on Windows Explorer.  
4. Scroll down in the left-hand panel until you find the CD-ROM drive. It will have 

a HyperStudio [D:] label. (Note: A different letter may designate your CD-

ROM drive.)  

5. Click on the + sign on the left of the HyperStudio CD Rom.  

6. Right mouse click once on the HStudio folder.  

7. Left mouse click on Copy in the resulting menu. 

8. Scroll back up the left hand panel to find the Program Files folder. Right 

mouse click once on it. 

9. Left click on Paste. 
 
 
 

Copying .DLL files from the CD-ROM to the hard drive.  

1. Click on Start.  
2. Click on Programs.  

3. Click on Windows Explorer.  
4. Scroll down in the left hand panel and find the CD-ROM drive (HyperStudio 

[D:]). (Your CD-ROM may be a different letter than “D.”) 

5. Click on the + sign to its left.  

6. Click on the + sign to the left of the Utility folder 

7. Single click on the Win_95NT folder to highlight it. In the right-hand panel, you 

should see the following .DLL files: 

 
i. AVIFile.dll  
ii. MSVCRT10.dll  
iii. MSVideo.dll  
iv. Paige32.dll  
v. VIC32.dll  

 

8. While pressing the CTRL key, click once on each of the listed files above to 

highlight them. 
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9. Right click on any of the highlighted files and left click on Copy. 

10. Scroll up in the left hand panel and find the Program Files folder. Click the + 

sign in front of it. 

11. Scroll down to the HStudio folder, right click on it, and click Paste. 
 

 

Copying font files from the CD-ROM to the hard drive  
1. Click on Start.  
2. Click on Programs.  

3. Click on Windows Explorer.  
4. Scroll down in the left hand panel to find the CD-ROM drive (HyperStudio 

[D:]). (Your CD-ROM may be a different letter than “D.”) Click on the + sign on 

its left. 

5. Click the + sign to the left of the Utility folder 

6. Click on the HSFonts folder to highlight it. In the right-hand panel, you should 

see the following font files:  

  
 

 
 
 
 
 

 
7. Press and hold the CTRL key, and click once on each of the files above to 

highlight them.  

8. Right click on any of the highlighted files and left click on Copy. 

9. Scroll up in the left hand panel to the Windows folder and Click the + sign in 

front of the Windows folder. 

10. Scroll down on the left to the Fonts folder, right click on it, and left click on 

Paste.  

Light.ttf  
Market.ttf  
Mlsaa.ttf  
Mlsae.ttf  
Mlsar.ttf        
Mlsgf.ttf 

Mlsgi.ttf  
Mlsgt.ttf  
Mlsgu.ttf  
Paint.ttf  
School.ttf 
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HyperStudio 3.2 Disk Installation.  
1. Double click on My Computer. 
2. Double click on 3 ½ Floppy Disk. 
3. Double click on run_last.exe.  

4. Select: This is my first time installing HyperStudio and choose Next. 

5. Choose Continue or Next when prompted. 

6. At the Select Destination Directory screen the install location must read 

C:\Program Files\HStudio. 

7. Choose Next, then Next again when prompted.   

8. Choose Finish when prompted. 

 
Setting file attributes  
1. Double click My Computer. 
2. Double click [C:]. 

3. Double click Program Files. 

4. Double click HStudio. 

5. Click Edit at the top of the window and choose Select All. 

6. Click File at the top of the window and choose Properties. 

7. Place a check mark in Read Only under Attributes. 

8. Choose Apply, then OK. 

 
Setting file associations  
1. Double click My Computer. 

2. Double click [C:]. 

3. Double click Program Files. 

4. Double click HStudio. 

5. Double click Home.stk. 

6. The Open with dialog box appears. Choose Other. 

7. Locate and double click HStudio.exe in the next dialog box. 
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8. Locate HStudio in the list select it. 

9. Verify that Always use this program to open this file is checked and choose 

OK. 
 

Creating a Program Shortcut  
1. Double click My Computer. 

2. Choose Program Files and then choose HyperStudio. 

3. Open the HyperStudio folder and right click on the HyperStudio.exe icon. 

4. Choose Create Shortcut. A shortcut icon will appear in the folder. 

5. Drag and drop the icon to your desktop. 

 
Installing QuickTime and Adobe Acrobat Reader. (If QuickTime and Adobe 
Acrobat Reader have not been previously installed on your computer, you 
will need to install them from the HyperStudio CD.) 
 

To install QuickTime 3.0  

1. Click Start and choose Run. 

2. Type in: D:\Utility\QTime\QuickTime_30\QuickTime_30.exe. 

3. Choose OK. 

4. Follow the prompts to complete the installation. 
 

To install QuickTime 2.1.2.59  

1. Click Start and select Run. 

2. Type in: D:\Utility\QTime\Win_95NT\qt32.exe 

3. Choose OK. 

4. Follow the prompts to complete the installation. 
 

To Install QuickTime Plug-in 

1. Click Start and select Run. 

2. Type in:  D:\Utility\QTime\Win_95NT\qtplug32.exe  

3. Choose OK. 

4. Follow the prompts to complete the installation. 
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To install Adobe Acrobat 3.0 

1. Click Start and select Run. 

2. Type in:  D:\Utility\ACROWIN\Setup.exe 

3. Choose OK. 

4. Follow the prompts to complete the installation. 

 

Fatal Exception OE Errors with HyperStudio 
 
Older versions of HyperStudio for Windows 3.0 or older, use the 16 bit 

QuickTime, so there is a chance that you could get the Fatal Exception OE error 

with an ATI or any TNT based chipset video card. 
 

1. Click Start and select Run.  

2. Type in qtw.ini  

3. Choose OK.  

4. Edit the line that says Optimize= to say Optimize=BMP.  

5. Close the window, and save the settings when prompted. 

 

Divide Error when starting HyperStudio 
 
This problem is related to a corrupted or out of date sound card driver.  Update 

the driver and start HyperStudio again. If the problem persists, please contact 

Technical Support at 1-800-HYPERSTUDIO [1-800-497-3778]. 
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